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Introduction 
 

Welcome to the user guide for the DME client version 4.0 for 
Android. 
This guide is divided into three parts: 
1. An introduction to DME - about the company Excitor A/S and 

what the DME system does. 
2. A description of various general concepts of the DME client. 
3. A description of each feature and function in the DME client. 

Administrators: For information about rolling out the DME 
client to many users, and detailed information about installing the 
client on all platforms, please see the Provisioning part of the 
DME Server Reference. 

Please note that this version of the DME client is compatible with 
both 3.5, 3.6, and 4.0 DME servers. Some features described in this 
manual only apply to DME 3.6 / 4.0 servers. The main areas of 
functionality supported by 3.6 / 4.0 and not 3.5 are the following: 
 To-do synchronization 
 Out of Office rules 
 Enhanced e-mail status (icons for replied to, forwarded, and 

follow-up flags) 
 Secure document viewer (as of 3.6 SP2) 
Whenever there is a difference, this will be indicated in the manual. If 
you are missing a feature in the client that is described in this manual, 
it may be because your DME server does not support it. 
 

Copyright information 

Copyright © 2007-12 Excitor A/S. 
All rights reserved. 
Due to continued product development, this information may change 
without notice. The information and intellectual property contained 
herein is confidential between Excitor A/S and the client, and remains 
the exclusive property of Excitor A/S.  
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If you find any problems in the documentation, please report them to 
us through our customer support services. Excitor A/S does not 
warrant that this document is error-free. Furthermore, Excitor A/S 
does not warrant that the illustrations and screenshots used in this 
document reflect your version or the latest version of the program 
described. For the latest version of this product documentation, go to 
the DME website DME http://www.excitor.com. 
No part of this publication may be reproduced, stored in a retrieval 
system, or transmitted in any form or by any means, electronic, 
mechanical, photocopying, recording or otherwise without the prior 
written permission of Excitor A/S. 
DME, DME Sync, and AdaptivePush are trademarks of Excitor A/S. 
Microsoft SQL Server, Microsoft Exchange, Windows, Windows 
Server 2003, Windows Server 2008, and Active Directory are 
trademarks or registered trademarks of the Microsoft Corporation in 
the United States and other countries. 
Lotus Notes® and Domino® are trademarks or registered 
trademarks of IBM Corporation, registered in the U.S. and other 
countries. 
Apple, Apple iPhone, iPod touch, and iPad are trademarks or 
registered trademarks of Apple Inc., registered in the U.S. and other 
countries. 
All other trademarks are property of their respective owners. 
 

Company information 

 
12, Spotorno Allé 
2630 Taastrup 
Denmark 
Phone: +45 70 21 68 00 
E-mail: mail@excitor.com 
Website: DME http://www.excitor.com 
 

http://www.excitor.com/
http://www.excitor.com/
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About DME 

DME (Dynamic Mobile Exchange) offers synchronization of push 
e-mail, PIM information (calendar, contacts, to-dos), and optionally 
files, to mobile devices. It fully integrates mobile device management 
with state-of-the-art security and efficient software deployment. DME 
is a mobile client/server solution that works with mobile phones, 
smartphones and PDAs using Android, Apple iOS, Symbian, Windows 
Mobile, or Windows Phone*) as operating system. DME is developed 
by Excitor A/S. 
The solution enables large and mid-size enterprises to deliver business 
mobility services to employees and to effectively manage and control 
mobile devices without compromising security. DME is device, 
network and operator independent and offers unparalleled TCO, 
unprecedented data and device security, and a very intuitive interface 
for users and administrators. 
*) Please note that not all server features are supported on all platforms. 
Contact your DME Partner for specific inquiries. 
 

Features and benefits 
 Convenient for the user: Push e-mail, calendar, contacts and to 

dos 
With DME on your mobile phone, smartphone, or PDA, you get 
your most critical and often used office tools in your pocket 
wherever you are, whenever you need it. E-mails appear on your 
phone the moment they hit your office mailbox.  

 Quickly back in the game: Instant service recovery 
Should your phone get lost or stolen, a new DME client can be 
pushed to a new phone in a few minutes after you purchase a new 
DME supported phone or borrow one from someone else – no 
matter where it happens. 

 Fretless security: Mobile security policy enforcement 
E-mails are encrypted over the air and on the device itself using 
full encryption (AES 128-bit or stronger). Shell protection of the 
entire phone, requiring domain password to access all features 
except picking up calls, gives you further security options. 

 Freedom and ease-of-use: Effective control of all devices 
Gain a complete overview of your devices – regardless of make, 
model, or platform. Information about the device model, versions 
and programs installed on the device is listed in the web-based 
DME control center for easy administration. Features, settings and 
available applications and network connections are all controlled 
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centrally and can only be changed by the users to the extent this is 
allowed by centrally applied security policies. Dividing the devices 
into groups makes it easy to change settings/features for many 
devices at a time. 

 Ease-of-use comes in many flavors: Simple support and 
administration 
Push software and upgrades via OMA, Apple MDM, SMS or WAP 
to the users, permit them to serve themselves, or automatically 
upgrade software when the users log on. For support purposes, 
retrieval of device configurations and connection set-up makes it 
possible for you to help users who cannot connect, and a log of 
user actions assists you in identifying the problems and solving 
them. Notification of changes to server status can be sent to the 
DME administrators to ensure they are alerted to problems 
quickly. 

 Cost containment: Control of ongoing mobile cost 
Data and voice logging allows you to monitor activity levels 
real-time, and identify “expensive” behavior which can be reduced. 
Heavily-used operators can be determined and connection 
preferences can be set as default. Build advanced reports to get a 
clear view of your organization’s mobile traffic using the integrated 
BI reporting tools. Link to a third-party Telecom Expense 
Management provider to build detailed reports, for instance for 
internal billing. 

 Freedom of choice: Versatility 
Works on any available network (WLAN/Wi-Fi, GSM, GPRS, 
3G/UMTS, EDGE...), operator, and on most devices from leading 
manufacturers. Works on Lotus Domino and/or Microsoft 
Exchange collaboration systems. 

Please note that the above applies to the full DME client. Note also 
that due to limitations specific to the some client platforms, a few of 
the features mentioned above are not supported on DME for those 
platforms. Contact you DME partner for specific inquiries. 
 

Terminology 

The following is a list of terms used in this guide, and an explanation 
of the term. 

Term Explanation 

DME Often used for the DME Client. 

DME Server The DME Web Administration Interface. 
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Collaboration system The server-based e-mail and calendar system that your 
company runs - either Lotus Domino (with Lotus Notes 
as the user front-end) or Microsoft Exchange (with 
Microsoft Outlook). 

DME menu The DME menu is the main menu in the DME interface. 
On some devices, you have to select Options to access 
the menu, on some you select More. 

Select To choose an item or a menu option, whether by 
clicking, tapping, or choosing in a menu. 

In some cases, there is more than one route to selecting an option. 
For instance, on some devices you can create an e-mail either by 
selecting Options > Create > E-mail or by tapping a New e-mail 
icon directly. The manual will usually only mention the regular menu 
route. 
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General concepts 
The following sections contain information that is good to know 
before you begin to use DME. The issues apply to clients of all or 
most platforms, and deal with Security, synchronization and import. 
 

Data security 

DME has a strong focus on security. All e-mails and other DME data 
are securely stored in a secure container on the device - even if the 
SIM card is changed or the battery runs out after you have logged in. 
All data remains encrypted at all times using strong encryption, and is 
only decrypted to memory while it is displayed on screen. 
All communication with the server is encrypted, and the server can be 
set up to require a client certificate, which further prevents attempts 
at unauthorized access from devices that the server does not already 
know. 
It is not possible to export any data from the device to be read 
elsewhere*). Even the clipboard is cleared of any text cut or copied to 
the clipboard when you exit the client (as of version 3.6). 
All DME-related data on the device (e-mails, calendar items, to-dos, 
contacts, and synchronized files, and other data: SMS messages, data 
on the memory card and internal memory) are deleted in the 
following events: 
 If the SIM card is changed (if set up by the DME administrator). 

See Changing SIM cards on page 12 for more information. 
 If the user name or password is entered incorrectly a number of 

times (as set up by the DME administrator). 
 If the DME administrator decides to do it. If the device is lost or 

stolen, the data on the DME client can be cleared remotely by 
sending a command from the DME server (remote wipe). You 
should always contact your DME Administrator immediately if you 
lose your device. From DME Server 3.6SP2, you can even log into 
a website and send a wipe command to the device yourself. 

In case a new user logs in, all DME-related data are deleted before the 
Desktop or Inbox is shown. 
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 If an Android device has ben wiped (for any reason), and the user 
tries to start the DME application, a message will say: DME is 
disabled. Please uninstall. The user will then have to reinstall DME 
in order to use it on that device again. 
*) Except in some cases where attachments can be printed or sent to 
other devices outside the secure DME container. However, this must 
be explicitly permitted by the administrator. See Attachments on 
page 39. 
 

Changing mailbox passwords 
Depending on your company's security policy, you must change your 
network password at regular intervals. If you use Exchange, your 
network password is the same as your mailbox password, but on 
Domino collaboration systems this is not necessarily so - here you 
use your internet password. The DME client depends on the mailbox 
password to gain access to synchronize your e-mail to the device. 
Your mailbox password can be changed from your desktop computer 
or from your device. If your collaboration system is based on Active 
Directory, a message may pop up telling you well in advance that it is 
time to change your password. If you ignore the warning, your 
current password will eventually become invalid, and you will be 
unable to log on to the system. 
You can either change your password from a desktop computer on 
the network or from the DME client.  
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 If your mailbox password is changed from a desktop computer on the 
network, and you have exited DME (for instance in connection with 
a phone reboot) so that your credentials are no longer encrypted 
in memory, then the new password has to be verified on the 
server the first time you log in to the DME client. When you log 
in, and DME recognizes you as a user and recognizes your 
password, but detects that the password has been changed on the 
server, the following message is shown: 

 
You are then asked to enter your new password. 
1. Select Yes to verify the new password on the server. 
2. Enter your old password. 
3. Select Log in. 
You can now use DME as usual. 

 If your mailbox password is changed from a desktop computer on the 
network, and your device still has your credentials encrypted in 
memory: If you are logged in, DME will log you out the first time 
the device communicates with the server (for instance in 
connection with a network push). When you log in again, you 
should use your new password. DME will assume that you have 
changed password on the server, verify your new password, and 
re-encrypt your credentials without you having to confirm any 
messages. 

 You can change your mailbox password from the client.  
1. Log in to the client as usual. 
2. Open the DME menu, and select Tools > Change password. 
3. Enter your existing password in the Old password field. 
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4. Enter a new password in the New password field, and retype 
it in the Confirm new password field. 

5. Select Change. 

 
DME sends the password change request to the server. If the 
server accepts the request, a message tells you that your 
password has been changed. If the server rejects the request, a 
message tells you why the command failed. If the command fails, it 
can be an issue with the server setup, and you should contact your 
DME Administrator. 

 

Switching users 
Unless forbidden by the DME Administrator, you can hand over your 
device to another person, even if it contains all your DME data. All 
e-mails, calendar items, to-do items, contacts, and other synchronized 
files and resources will be erased when the new user logs in. 
The new user is taken through the same verification process as 
described in Logging in. 
 

Changing SIM cards 
If you change the SIM card in your device, the DME client will ask for 
the new phone number the first time you log in to the DME client. It 
is important that the phone number is correct, as many features 
depend on the DME server's ability to send commands by SMS to the 
device. 
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1. Enter the phone number. 
2. Select OK. 
The device phone number can also be changed in the general settings 
(see General settings on page 100). 
Depending on the setting Action on SIM card change in the 
security settings, your DME data will be wiped from the device when 
you change the SIM card, or your device will be locked, or you are 
allowed to log in as usual. 
 

Synchronization overview 

The basic idea of the DME client is to keep the e-mail, calendar 
system, contacts, and other resources on your mobile device 
up-to-date with the corresponding items on the corporate network. 
To do this, the DME client is synchronized with the collaboration 
system or the file server. E-mails, calendar items, contacts and other 
resources are synchronized with the corporate collaboration system. 
On some platforms, you can also synchronize files on the DME server 
or in a network location with your mobile device. File synchronization 
requires a special license - consult your DME administrator for more 
information. 
 

What is synchronized 
In the synchronization (sync for short) process, DME checks the 
following: 
1. Have any items been created? An item could be an e-mail, a 

contact, a calendar item, a to-do, or possibly a file. If an item has 
been created, it is copied to the system on which it does not yet 
exist (for example, if an e-mail was created and sent from the 
mobile device, the e-mail is copied to the Sent folder on the 
collaboration system).  
Furthermore, the e-mail, calendar and other items on the mobile 
device are synchronized with respect to the time span for which 
items should be shown according to the settings. This is called the 
synchronization window. For instance, the settings may specify that 
the e-mail application should show e-mails for the last 7 days. The 
sync process will then clear e-mails older than 7 days from the 
Inbox and other mailboxes except Drafts (on the mobile device 
only). 
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2. Have any items been deleted? If an item, for instance a meeting, has 
been deleted in the collaboration system, the deletion will be 
reflected on the mobile device. Note that e-mails deleted on the 
mobile device will not be deleted on the collaboration system, if 
the setting Delete only locally is enabled. Note also that you 
will not receive notification of changes when e-mails are deleted 
from the server. 

3. Have any items been edited? If you for instance edit a contact on 
the mobile device or on the collaboration system, the change will 
be synchronized. In the same way, if you edit a spreadsheet on the 
mobile device, the sync process will update the spreadsheet on the 
DME server if file sync. is enabled. 

 

Conflicts 
In some cases, a conflict may arise. For instance, if a meeting has been 
moved to another time on both the collaboration system and the 
mobile device, DME will resolve the conflict by moving the meeting to 
the time indicated in the DME client, and a message will be sent to 
you with information about this fact. 
Also, during the initial synchronization of the client or during a 
subsequent reset, duplicate contacts or calendar items may occur. In 
this case, the duplicate entries will be created, and an e-mail listing the 
duplicate entries will be sent to you (using DME Server 3.6). 
 

Synchronization methods 
The DME client can be synchronized in four ways: 
1. Server-initiated sync. (Push) 

Whenever someone sends you an e-mail, a meeting invitation, or 
similar, it is received by the collaboration system. The DME server 
constantly checks for such updates in the collaboration system, 
and sends a notification by network push, Apple Push, or as an 
SMS (a text message) to the mobile device on which your DME 
client is installed. The notification is picked up, read, and (in the 
case of SMS push) deleted by the DME client, and a sync is 
initiated to make the device reflect the change in the collaboration 
system. The DME client will optionally notify you with a sound 
whenever a new e-mail has arrived in this way. Push sync is 
enabled and scheduled by the DME administrator. Notifications 
can also be sent in case system settings are updated or a server 
command is issued. 
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Note that notifications may be disabled on the server, and that 
they may disabled if the device is roaming (see Roaming). 

2. Scheduled sync. 
The client can be set up to synchronize at regular intervals. When 
synchronizing, all enabled resources are synchronized - that is, if 
the Sync. option for the resource in question (for instance To-do 
sync.) is enabled. The scheduled sync intervals are the same for all 
resources. 

3. Pull sync. 
For e-mail and calendar items, you can set up a separate schedule 
for synchronization. This way you can for example set up 
scheduled sync intervals for contacts, to-dos, and files, disable 
scheduled sync for e-mail and calendar, and enable pull sync for 
e-mail and calendar with a more frequent schedule. 

4. Manual sync. 
Finally, it is possible to synchronize the client with the server 
manually by selecting a menu item in the client. You can 
synchronize the different resource types individually, or you can 
choose to sync all resources at the same time. 

During the synchronization operation, the DME client shows a status 
messages about the current sync process in the interface. In order to 
optimize speed and bandwidth consumption, the DME server builds a 
list of commands to be executed by the client the next time it 
connects with the server. This is called a "command stack". When the 
client connects with the server, for instance in order to synchronize 
e-mail, the server will force the execution of those commands on the 
client. For this reason you may experience that, for instance, the 
e-mail sync you requested is followed by a calendar sync - meaning 
that the server takes the opportunity to update your calendar because 
a change has occurred. 
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While the synchronization is in progress, you can cancel it by 
selecting Synchronize > Cancel sync. from the DME menu. 

 
 

Initial import and reset 

The first time you log in to the DME after installing the client, DME will 
receive a set of default client settings from the server. Based on these 
settings, DME will import data from the server into the enabled data 
stores. For instance, if you have enabled e-mail sync. and calendar 
sync., DME will immediately and silently import your e-mails and 
calendar items from the server. This is called the initial synchronization. 
Your DME administrator has made two important choices which 
affect your initial synchronization: The DME settings for 
Calendar/Contacts mode and Action to perform on client 
upon initial import.  
 If your DME administrator has selected Wipe as initial import 

action, and your calendar and/or contacts are set to Open mode, 
all calendar items and contacts that existed on the device before 
you installed DME are deleted before they are imported from your 
collaboration system mailbox. If you have calendar items and 
contacts that do not exist in your collaboration system also, and 
you want to keep these, you must synchronize them with another 
system first. 

 If the DME administrator selected Merge as initial import action, 
and your calendar and/or contacts are set to Open mode, DME 
will send all your calendar items and contacts to the server. DME 
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will then add those calendar items and contacts that do not 
already exist on the collaboration system to your collaboration 
system calendar and address book. DME runs an extensive 
duplicate control to weed out duplicates. This is not too hard to 
do for calendar entries, but requires careful analysis (and thus 
time) for contacts. 

If your calendar and/or contacts are set to Secure mode, DME will 
not touch your local calendar or contacts, regardless of the Action 
to perform on client upon initial import setting. The import or 
reset only affects the stuff that DME is actually handling. 
If you enable the synchronization of another resource after the initial 
synchronization, for instance Contacts, then the initial synchronization 
of this resource will actually be an import.  
This Reset function corresponds to an initial synchronization. If you 
think that any of the resources on your phone are out of sync, you 
can reset the DME data on your phone by choosing Tools > Reset in 
the DME menu. This will perform an import of all resources according 
to the rules outlined above. 
Note that the DME administrator can also force an import of items 
on your device. In this case, you will not be asked if you want to keep 
the original entries; the device will simply start effecting the command 
and replace from server. 
In the case of contacts in Open mode, you may need to add device 
specific features to the contacts, such as photos, speed dial keys, etc. 
after a reset. These settings will not be lost when you synchronize 
contacts with the server (but they will after a reset). 
See also Flexible field mapping on page 17 below for more 
information about contacts. 
 

Flexible field mapping 
It is possible to create custom mappings between fields in Domino or 
Exchange and contacts on the device. You can use this feature for 
enforcing company policies. 
For instance, you may have a policy of always calling the internal office 
number when calling a colleague in order to cut costs. You can then 
decide to add the internal office number to the "Pager" field in Notes, 
and map the Pager field to the "Telephone (business)" field on all 
devices. 
Custom mapping should be carefully planned, and can only be set up 
in cooperation with a certified DME partner. Partners may request 
special documentation from Excitor A/S. 
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User guide: Android 
devices 

DME supports a wide range of Android devices from HTC, Sony 
Ericsson, Google, Motorola, and other vendors. For a list of 
supported devices, see the Supported Devices - Android 
http://www.excitor.com/Default.aspx?id=47&device_search=Andr
oid&device_sortby=product_group website. 
The model used throughout this manual for illustration purposes is 
the Sony Ericsson Xperia X10, running Android 2.3: 

 
A note about terminology  
Android devices generally have three buttons: Back, Home, and 
Menu. These buttons are used in DME as in other apps for Android: 
 Back 

Go back one screen. For instance, pressing Back in an open 
e-mail takes you back to the folder from which you opened the 
e-mail. If you get stuck somewhere, try pressing this button! 

 Home 
Pressing Home shows the Android Home screen. Long-pressing 
the button shows currently running apps. 

 Menu 
Pressing Menu opens a menu, which applies in the current 
context. For instance, pressing the button in an open e-mail shows 
your options for the current e-mail (reply, forward, delete, etc.). 
In this guide, we refer to this button as the DME menu. 

Android devices can be rotated between Portrait and Landscape 
orientation. DME automatically adjusts the display to match the 
orientation. In this guide, we mostly show screenshots from the 
Portrait orientation. 

http://www.excitor.com/Default.aspx?id=47&device_search=Android&device_sortby=product_group
http://www.excitor.com/Default.aspx?id=47&device_search=Android&device_sortby=product_group
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The Notification Panel shows notifications received by the phone, 
including new text messages, new e-mail etc. When you open the 
DME Inbox, any "New e-mail" messages from the Notification Panel 
will be removed automatically by DME. The Notification Panel is also 
used for informing you if DME forces another application to exit 
because the app has been blocked by the DME administrator. In this 
case, a message will say "X" application was blocked by DME. 
 

Installing DME on Android devices 

 
OMA DM installation 
Installing using OMA DM is not supported. 
Push installation 
Only SMS push is supported. 
When the DME Administrator has "pushed" DME to your phone, you 
will receive an SMS with the text DME Software Installation and a 
link to a secure Internet address. 

 
1. Tap the link, and choose to open the link in the browser. 

The browser opens, and downloads the client. 

 
2. Tap the downloaded client. 
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If DME was already installed, and you are upgrading to a new 
version, the following message is shown: 

 
Tap OK. 

3. A message with the following text is shown: 
Allow this application to: 
-along with a number of permission settings. These settings allow 
DME to operate according to the DME client guide. 

 
4. Tap Install. 
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5. The DME application is installed. When done, the following 
message is shown: 

 
6. Tap Open to launch DME. 
Google Play 
The DME client is also available from Google Play. However, when 
installing from Google Play, you have to enter the server path 
yourself. See Logging in for the first time on page 22 for more 
information. 
 

Starting the DME client 
The DME client will usually be set up to launch automatically when 
you start the device. DME contains a number of security features that 
depend on the client being started. Furthermore, the client contains a 
feature that makes it impossible to shut down the client without also 
shutting down the device. For more information, see Data security 
on page 9. 
You can see if DME is running by an icon in the top notification panel:  

 if network push is enabled and active, 

if network push is enabled and not active, or if network push is 
not enabled. 
If DME is not running, locate the DME logo, and tap it. 
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If DME has been opened recently, you can long-press the Home key 
to see a list of recent applications, and then tap the DME icon. Or you 
can add a shortcut to DME to your Home screen (in the Home 
screen, press the Menu button, tap Add, tap Shortcuts, tap 
Applications, and then tap DME). 
If your DME administrator requires you to comply with a certain set 
of Android security policies, you must activate DME as Device 
Administrator for your device. When you do this, the DME system is 
able to manage your device. For instance, if you lose your device, the 
DME administrator can send a command to your device, which will 
delete (wipe) all data on the phone so that a 3rd party cannot gain 
access to the data stored on the phone. Or the administrator can 
specify minimum requirements for your device PIN code/password. 
In order to enable the DME system to administer your device, you 
must accept a prompt from DME: 

 
By tapping Activate, you grant DME the right to administer your 
phone. Note that you cannot log into DME until you have done this. 
You can also enable DME as a device administrator from Settings > 
Location & Security > Device administration on the device. 
(The actual path to this screen may differ on different Android 
models.) 
On Basic MDM clients, you must accept the message in order for the 
DME client to run at all. 

Note that in order to uninstall the DME client, you must 
deactivate DME as device administrator first from the Device 
administration screen on your device. 

 

Logging in for the first time 
When the DME client is launched for the first time, DME starts the 
initial setup wizard.  
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 Logging in to DME for the first time 
1. Login credentials: First, DME asks for your user name and 

password. 

 
Use the same user name and password that you would use for the 
collaboration system on your desktop PC. Contact your IT 
department if you have problems with your user name or 
password. 

 Lotus Notes users should use their internet password here (the 
same as for Notes Webmail). 

2. Server path: If the installation file was pushed to your device 
from the server, the server path is sent to the device along with 
the installation file, in a separate SMS. When DME launches, the 
server path is read from that SMS. The server path is the location 
of the DME server on the Internet. 
If DME was installed through Google Play, DME asks you for the 
server path (host name). 
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The server path has the form 
https://dme.yourcompany.com:5011, where 
dme.yourcompany.com is the name of the server where DME is 
installed, and :5011 is the port number. If you do not know the 
right host name, ask your DME administrator for the server path. 
https:// (Secure connection) and port :5011 are entered 
automatically. Only change these if you are told to do this by a 
DME administrator. 

3. Private key password: If you are using Notes encrypted mail or 
S/MIME, you should enter the password for your private key in the 
Private key password field. Your private key is used for 
decrypting encrypted messages sent to you, and for signing private 
messages. If you do not enter a password here, you cannot read 
encrypted messages or sign new messages from your mobile 
device. 
If your collaboration system is using Notes Encryption, you 
must enter the password for your user ID file. 
If your collaboration system is using S/MIME, enter the password 
for your private key in this field. You must also upload your 
personal certificate to the DME server (using myDME).  
For more information about Notes Encryption, S/MIME, and 
myDME, please contact your DME administrator. 

Tap Next. 
DME uses the provided information to log in to DME for the first 
time. Since this is the first time you enter your user credentials, DME 
needs to make a connection to the server to verify that your user 
name and password match, so the first-time login takes a little longer 
than usual. DME stores your password in multi-hashed, encrypted 
form (that is, very secure) on the client. Therefore, the next time you 
log in to the client, you do not need to make a server connection to 
verify your login. However, when you do make a connection (for 
instance when you synchronize e-mail), your login credentials will be 
verified again. 
Security policies: If the DME administrator has set specific security 
policies for your device, you will now be prompted to make sure your 
device complies with these policies. You may for instance be taken to 
the screen on your device where you can specify a device PIN code 
or password, where you will be guided to set it correctly. 
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Some security policies require that the DME system must administer 
your device. You must allow DME to do this in order to use DME. 
DME shows the following prompt, which you must accept: 

 
By tapping Activate, you grant DME the right to administer your 
phone. Note that you cannot log into DME until you have done this. 
If the login was successful, the next (and last) step of the setup wizard 
is shown: 

 
1. Phone number: Enter the phone number of your device, if 

available. 
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2. Swipe pattern: Instead of using your collaboration system 
password for logging in, it is possible to substitute the password 
for a swipe code. A swipe code is defined by moving your finger 
across the screen in a certain pattern. Tap the Set unlock 
pattern field to set the swipe pattern. 

 
Move your finger vertically, horizontally, and diagonally across at 
least 4 of the tiles on this screen. Repeat, and your swipe code is 
set. For more information, see Setting swipe code on page 96. 
Note that both the phone number and the swipe code can be 
defined later. 

3. Tap Done. 
4. Import: If the login process is successful (that is, DME can 

establish a connection to the DME server and log in using your 
user name and password), DME will now import your e-mail and 
other DME resources (calendar, contacts etc.). See Initial import 
and reset on page 16 for more information. 

You have now logged in to DME for the first time, and the DME 
Desktop is shown. 
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Logging in 
When launching DME, you are asked to enter your user name and 
password: 

 
Use the same user name and password that you would use for the 
collaboration system on your desktop PC. Contact your IT 
department if you have problems with your user name or password. 

 Lotus Notes users should use their internet password here (the 
same as for Notes Webmail). 
The client remembers the user name from your last login, unless the 
DME administrator has disabled this feature for additional security. 
If you have defined a swipe code (see Setting a swipe code), you may 
log in using that rather than your LDAP/AD password. If you have 
defined a swipe code, the Login screen will look like this (in Portrait 
mode only): 
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Move your finger across the screen in a pattern you have defined 
previously to log in. Note that this can only be done in Portrait mode. 
If you rotate the device to Landscape mode, you can log in using your 
regular password. You have two chances to enter the correct swipe 
code - if the second attempt fails, you have to enter your regular 
network password to log in. 
If you accidentally move your finger across tiles that you did not 
intend to touch, you can undo the current swipe by tapping another 
tile with another finger while not releasing the first finger from the 
screen. The screen will flash, indicating that your swipe attempt was 
canceled, and you can try again. 
For more information, see Setting swipe code on page 96. 
 

Removing the client 
Uninstalling the client from a device follows the usual procedures for 
each platform. 
The DME administrator may have specified on the server that you are 
never allowed to uninstall the client. In this case, you are unable to do 
so. 
Alternatively, the DME administrator may specify that you are only 
permitted to uninstall the client if you are logged in. In this case, you 
will be prompted for a user name and password when you attempt to 
uninstall the client. If you enter the correct credentials within one 
minute, you will be permitted to continue uninstalling the client. 

 Uninstalling the DME client for Android 
1. If you have accepted the "DME Device Administration" request 

after installing or launching the DME client, you must go to Menu 
> Settings > Security > Select device administrators (the 
path to this setting varies depending on device), and deactivate 
DME Device Administration in order to be able to remove the 
DME client. 

2. From the Home screen, tap the applications bar, and tap 
Settings. 

3. Tap Applications > Manage applications. 
4. Tap the DME application. 
5. Tap Uninstall. 
The DME client is removed from your device, including all data that 
was protected by DME. 
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The DME Desktop 

The main DME screen is the Desktop. The Desktop gives you quick 
access to the most commonly used features in DME. 

 
Tap an icon to run the function associated with the icon. 
A green arrow symbol on top of an icon means that there are items 
of the category in question that have not yet been synchronized: 

 
If an icon has a faded color, it means that the initial 
synchronization/import has not yet taken place for the resource in 
question. 
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Desktop actions 
The following is a brief explanation of each Desktop icon, with 
references to more information. Note that the Desktop only shows 
icons for functions that are enabled - for instance, if Contact sync. is 
not enabled, there will be no icon for Contacts. 

 
Go to the Inbox (see E-mail on page 35). 

 
Go to the Unread folder (see Working with folders on page 30). A 
badge shows the number of unread e-mails here. 

 
Go to the Folders view (see Working with folders on page 30). 

 
Open the internal DME Calendar (see Calendar on page 60) 

 
Go to the Contacts application (see Contacts on page 78) 

 
Go to the To-do folder (see To-do) 

Apart from these icons, you can use the DME menu (the Menu 
button) to access all functions in DME. You can access the DME menu 
from all views in DME. For an overview of the DME menu, see Menu 
tree on page 111. 
For information about how to configure your Desktop, see Desktop 
settings on page 111. 
 

Working with folders 

The DME mailbox consists of at least the following folders: Inbox, 
Outbox, Drafts, Sent, and Unread. The first four of these folders 
function as the corresponding folders on the collaboration system 
(Notes or Outlook). The Unread folder is a smart folder which shows 
all unread messages in any folder in the DME client. When an e-mail in 
the Unread folder is read, it disappears from view - but naturally 
remains in the folder from which it originated. 
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Apart from these standard folders, subfolders created on the 
collaboration system (Notes or Outlook) are also shown on the 
client. However, the content of these folders is only shown if you 
enable the synchronization of e-mails in the folders (see Folders 
settings on page 106). With settings similar to the e-mail settings (see 
E-mail settings on page 104), you can specify how many e-mails you 
want to see in each folder (by age in days) and whether you want to 
synchronize e-mails in folders at all. This is specified as a system-wide 
setting. You can also specify different settings for each folder, 
including whether you want to receive a notification when a new 
e-mail arrives in a folder, as described in the following sections. 
 

Navigating the folder tree 

To move between folders, tap the desktop Folder icon , or 
select View > Folders in the DME menu. When you do this, DME 
shows a list of all folders in the system. Folders with subfolders are 
shown with a small gray triangle on the right-hand side of the folder 
name. 
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Tap a folder to open it in mailbox view, or press the Back button to 
return to the Desktop. 
You can set options for the synchronization of folders. See more in 
the next section. 
 

Setting folder options 
You can set defaults for the way e-mail folders should be 
synchronized between collaboration system and client (see Folders 
settings on page 106). If you have many folders on the collaboration 
system, it is recommended that you set up very restrictive default 
settings for performance reasons, and loosen up on individual folders 
as described below. 
To change synchronization options for a folder, open the folder view 
described in the previous section, and long-press the folder you want 
to customize. Then tap Settings. The following screen is shown: 
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 Use default values 
If this setting is On, the current folder uses the general settings 
specified (see Folders settings on page 106). If Apply to 
subfolders is also selected, the default settings will be applied to 
all subfolders below the current folder as well, when you press 
Done. If this setting was Off, and you change it to On, the 
settings in the remaining fields in this screen will be reset to the 
default values when you press Done. 
If you want to apply other settings than the default settings to this 
folder, you must set this field to Off. 

 Sync. folder 
This option can only be changed if Use default values above is 
set to Off. If this setting is On, e-mails in the current folder are 
synchronized with the collaboration system, using the 
synchronization window defined in the field Days back below. To 
avoid too high load on the DME server, you should only 
synchronize those e-mail folders that you really need on the 
device. You can for example consider to not synchronize folders 
containing graphics-intensive newsletters etc. 

 Days back 
This option can only be changed if Use default values above is 
set to Off. When e-mails are synchronized, e-mails from the last 
number of days selected here will be synchronized and available in 
the current folder. 

 Include in mail scan 
This option can only be changed if Use default values above is 
set to Off. If this setting is On, you will receive notification when 
a new e-mail arrives in the current folder. New e-mail can "arrive 
in" subfolders by means of rules, which are set up on the 
collaboration system to automatically distribute new e-mails in 
folders. 

 Apply to subfolders 
If this setting is On, the settings made in other fields in this screen 
are propagated to folders below the current folder when you 
press Done. Use this function with caution, as the setting may 
affect many folders. Note that you can choose this option 
regardless of the value of the field Use default values above. 

Note that you cannot modify the settings of the system folders 
(Inbox, Sent, etc.). Instead of synchronizing e-mail to the client, you 
can use the Search e-mail (on server) function to find e-mails in 
any folder on the collaboration system. See E-mails (on server) on 
page 58 for more information. 
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E-mail 

Tap the  icon from the Desktop (DME menu: View > 
Folders > Inbox) to open the Inbox, which displays the e-mails and 
meeting invitations that have been synchronized to the client. 
The Inbox is one of the five system folders: Inbox – Outbox – Drafts 
– Sent – Unread. To switch between these folders, select More > 
View > Folders in the DME menu. You can access all your mailbox 
folders this way (see Working with folders on page 30). 
Above the list of e-mails, you can see the total number of e-mails in 
the current folder. The number of unread e-mails is shown in 
parentheses. 
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The illustration below shows the main DME mailbox interface. 

 

The received time of the e-mails is shown as a time of day when 
received today, and as a day in the week for e-mails received during 
the past week. E-mails received before that show with the full 
received date. 
On the left side of of each e-mail in the mailbox view, one or more 
icons are displayed. The icons tell you quite a bit about the e-mail at a 
glance: 

 An unread e-mail is shown with an orange dot. When the e-mail 
has been read, the dot is removed. 
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The e-mail has been replied to. 

The e-mail has been forwarded. 

 The e-mail has been flagged. 

 This icon after the Sender name indicates that the e-mail or 
meeting invitation contains one or more attachments. 

 This e-mail is a meeting invitation. 
Drag up/down, or flick to see more e-mails. 
If you rotate the device sideways, the mailbox view is shown in 
landscape orientation. You can rotate all screens in DME in this way. 
Long-pressing an e-mail in the mailbox folder view is a shortcut to 
various functions. See Other e-mail options on page 43. 
If you want to perform the same function on multiple e-mails, tap the 
Edit button (second in the top toolbar). This lets you select multiple 
e-mails. See Selecting multiple items on page 51. 
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Reading e-mails 
To open an e-mail, tap the e-mail in a folder. 

 
 

Links 
E-mails and meeting invitations may contain links such as e-mail 
addresses, phone numbers, and web links. Whenever a link is found, it 
is written in blue and underlined (like links on a web page). 
 Phone numbers 

When you tap a phone number, DME opens the Phone application. 
You can then press the Call button to dial the number. 



DME Client User Guide 4.0 
User guide: Android devices 

 

39  © 2012 Excitor 
 

 E-mail links 
When you tap an e-mail address, DME creates a new e-mail for 
that address. 

 Web links 
When you tap a web address, the link is opened in Browser. 

 

Attachments 
When you receive an e-mail with one or more attachments, you will 
see an attachment icon in the mailbox  and in the header area of 
the open e-mail. In the open e-mail, the icon also says how many 
attachments are included - for instance 

  

 Graphics that have been embedded into an e-mail may be shown 
as attachments on the client. This requires that you run Domino as 
your collaboration system. 

 Opening an attachment 
1. Open the e-mail. 
2. Select Attachments in the DME menu. 

or 

Tap the  icon in the header area of the e-mail. 
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A list of the attachments to the e-mail is displayed. To save 
transmission time and space on the device, attachments are not 
stored on the device unless you specifically choose to download 
them.  

 
3. Tap an attachment. 
4. Select Yes to download the attachment. 

DME connects to the server, and retrieves the attachment. 
The actual display of the attachment depends on your DME server 
version and your license: 

5. If your DME server is running a version less than 3.6 SP2, or you 
do not have a license for the DME Document Viewer, you must 
now select Yes to allow the attachment to be decrypted to disk. 
The attachment file is stored in a temporary folder on the device 
disk, which is outside the secure DME area. It is deleted from the 
temporary folder again when you log out of DME. If DME cannot 
delete the attachment immediately when you log out, for instance 
if it is still open in the application, it will keep trying at regular 
intervals. 
The device supports several types of attachments depending on 
the programs installed. By default, the device will recognize several 
types of image files such as .bmp and .jpeg, sound files such as 
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.wav, and text files. Usually the device will also be able to open 
Microsoft Office and Adobe PDF files. Please refer to the user 
manual of the device for further information. 
If the file does not have a file type association, an error message 
will be displayed, and the file will not be downloaded. If you have a 
program that you know will open the file of the type in question, 
you must set up a file association to that file type, and try to 
download the attachment again. For information about file 
associations, see your mobile phone documentation or the 
documentation for your mobile phone operating system. 

6. If your DME server is running version 3.6 SP2 or above, and you 
have a license for the DME Document Viewer, the attachment is 
opened directly in the DME Document Viewer. There is no need 
to ask if you want to allow the attachment to be decrypted, 
because the attachment is stored within the secure DME container, 
and is only decrypted in memory while shown on the screen. 

 
When the attachment is shown in the DME Document Viewer, a 
number of options are available to you. For more information 
about these options, see the built-in help file by pressing the 
Menu button > More in the top toolbar > Help. 
The DME Document Viewer currently supports the following file 
formats: 
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 Microsoft Office documents 
 Comma-separated value files (opened as Excel spreadsheet) 
 Plain text files 
 Adobe PDF documents 
 Korean Hangul documents 
 Image files: WMF, EMF, BMP, GIF, JPEG, PNG 

In the attachment list, you can see which attachments are only located 
on the mail system server, and which have been downloaded to your 
device. 

 
Press the Back button to return to the e-mail. 
 

Removing attachments 
When you download attachments to the device, the attachments will 
take up space on the device. To free this space, you have the option 
to remove downloaded files from the device. The attachments will 
not be deleted on the mail system, only on the DME client. 

 Removing all attachments from the device 
1. Go to the mailbox view of any folder. 
2. Open the DME menu, and select Actions > Delete all 

attachments. 
3. Press Yes to confirm. 
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All attachments downloaded to the device are deleted. 
 

Viewing e-mail details 
You can see a summary of information about the e-mail you are 
reading. 

 Viewing e-mail details 
1. Open an e-mail. 
2. Open the DME menu, and select More > E-mail details. 
An information box shows information about the current e-mail. 
The information consists of the date and time the e-mail was received, 
a list of recipients of the e-mail (individual recipients or a mail group), 
importance level, and security information. 
Tap OK to exit the information box. 
 
 

Other e-mail options 
Apart from the options concerning attachments and e-mail details 
mentioned above, you can open the DME menu for more options 
(some of the options are available as buttons at the bottom of the 
e-mail screen as well): 
 Reply / Reply to All 

Create a reply to the e-mail - see Replying to e-mails on page 47.  

Available from: Directly from the e-mail using ; Long-press an 
e-mail in a mailbox folder. 

 Forward 
Forward the e-mail - see Forwarding e-mails on page 47. 

Available from: Directly from the e-mail using ; Long-press an 
e-mail in a mailbox folder. 

 Forward with attachments 
Forward the e-mail, including attachments - see Forwarding 
e-mails on page 47. 

Available from: Directly from the e-mail using ; Long-press an 
e-mail in a mailbox folder. 

 Delete 
Delete the current e-mail. 

Available from: Directly from the e-mail using ; Long-press an 
e-mail in a mailbox folder; Select multiple e-mails in a folder and 
tap the Delete icon or select Actions in the DME menu. 
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 Mark read (or unread) 
Mark the current e-mail as read or unread. 
Available from: Directly from the e-mail; Long-press an e-mail in a 
mailbox folder; Select multiple e-mails in a folder and tap the 
Mark icon or select Actions in the DME menu. 

 Flag/Clear flag 
Set or clear the follow-up flag. E-mails marked with a follow-up 
flag have a special status in the collaboration system. 
Available from: Actions menu in the e-mail; Long-press an e-mail in 
a mailbox folder; Select multiple e-mails in a folder and tap the 
Flag icon or select Actions in the DME menu. 

 Add to contacts 
Add the sender of the current e-mail to your local address book. 
Available from: Actions menu in the e-mail. 

 Move to folder 
Shows the folder list. Browse to a folder, and tap OK to move the 
e-mail to that folder. See Moving to other folders on page 53. 

Available from: Directly from the e-mail using ; Long-press an 
e-mail in a mailbox folder; Select multiple e-mails in a folder and 
tap the Folder icon or select Actions in the DME menu. 

 

Creating and sending e-mails 
 Creating and sending an e-mail 
1. Select Create > E-mail from the DME Desktop. 

or 

Tap the Compose e-mail icon  from a mailbox. 
2. Enter message details as described in the next section - see E-mail 

details on page 45. 
3. Tap Send in the top toolbar. 
The e-mail is now saved in the Outbox. Depending on the e-mail 
settings, the e-mail is sent immediately or queued for the next 
scheduled or manual synchronization (see E-mail settings on page 
104). When the e-mail has been sent, it is moved to the Sent folder. 
Note that you can also create an e-mail by finding one or more e-mail 
addresses through the Global Address Book first, and then choosing 
to create an e-mail using the selected e-mail addresses. For more 
information, see Global Address Book on page 55. 
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E-mail details 
The e-mail form works like a normal e-mail with fields for Send to, 
Carbon Copy (CC), Blind Carbon Copy (BCC), Subject, and 
Body. If you need to type multiple recipients in a field, you can 
separate the recipients using a comma (Lotus Notes style) or a 
semicolon (Outlook style). 

Tip: Some collaboration systems are able to resolve names of 
known users. This means that you only have to enter the short 
name as the e-mail recipient. For instance, you could just enter 
sad in the Send to field, and the collaboration system would 
resolve (expand) the name to Sabine.Adelhof@excitor.com 
automatically. Ask your DME administrator if this is possible in 
your setup. 
Tip: For devices without a full keyboard, you can insert a new line 
in the e-mail body by pressing the center or right scroll key 
(depending on device model). 

 

Entering recipients 
With the cursor placed in the To, Cc, or Bcc field, you can start 
typing the name of a recipient. DME will try to predict who you want 
to enter as a recipient, and shows suggestions in a drop-down list 
below the recipient field: 

 
DME builds this list from all the e-mail addresses found in your 
mailbox folders, from participants in meetings where you are a 
participant or chair, and from your local contacts. 
When you start typing, DME will match the typed characters with the 
names and e-mail addresses in the list of addresses. For instance, 
typing a "c" might match the following entries in the list: 
 "Chris Rea <chris.rea@music.com>" 
 "Hooray Carlton <hooray@freude.de>" 
 "Melanie C. <melc@spice.com>" 



DME Client User Guide 4.0 
User guide: Android devices 

 

46  © 2012 Excitor 
 

As you type more characters, the list will grow shorter. In the 
example above, typing an "a" after the initial "c" will limit the list to 
"Hooray Carlton <hooray@freude.de>" only. 
The list is sorted alphabetically. 
Flick through the list, and tap an e-mail address to add it to the 
recipient field. To add another contact, start typing the name of the 
next recipient. 
 

Selecting message options 
You can sign, encrypt and mark the message with high importance. 

 Setting message options 
1. Open the DME menu in the e-mail you are creating, and select 

Message options. 
2. Tap to enable or disable each option: Sign, Encrypt, and High 

importance. 
3. Tap OK or Cancel to return to the e-mail. 
Please note the following about signed and encrypted e-mail:  
 When you send a signed e-mail, and the DME server cannot find 

your private key on the server, an e-mail with a notification of the 
error "The DME Server could not send the signed S/MIME e-mail") 
is sent to you by the DME server. Your e-mail will be sent to the 
recipient; however, it will not be signed. 

 When you send an encrypted e-mail, the DME server needs to 
know the public key of each of the recipients of the e-mail. If the 
public key of one of the recipients is unknown to the server, an 
e-mail with a notification of the error ("Cannot find certificate for 
recipient: xx") is sent to you by the DME server. The e-mail will 
not be sent to any of the recipients. 

Using signed and encrypted e-mail requires special setup. Please 
contact your DME administrator. 
 

Saving as draft 
If you want to continue editing an e-mail at a later time, you can save 
the e-mail as a draft. 

 Saving an e-mail as a draft 
1. Open the DME menu, and select Save as draft. 

or 
2. Close the e-mail by pressing Back, and select Yes when asked to 

save as draft. 
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The e-mail is saved to the Drafts folder, and you are returned to the 
mailbox. When you want to finish the e-mail, you can open it from 
the Drafts folder, edit it, and send it in the usual way. 
 

Replying to e-mails 
When replying to an e-mail, you can choose to reply to the sender 
only or reply to all (if the e-mail was sent to more people than 
yourself). 

 Replying to an e-mail 
You can reply to e-mails in two ways. Either: 
1. Open the e-mail you want to reply to. 
2. Tap the Reply icon at the bottom of the screen, and then tap 

Reply or Reply to All. 
or 
Select Reply or Reply to All in the DME menu. 

Or: 
1. Long-press the e-mail you want to reply to in a mail folder. 
2. Tap Reply or Reply to All from the pop-up menu. 
A new e-mail is created for the original sender and possibly all original 
recipients. The e-mail history is always included in the reply. 
You can now add text and attachments to the e-mail and send it. See 
Sending attachments on page 48 for information about how to work 
with attachments in e-mail replies. 

The original e-mail in the mailbox will be marked with a , 
indicating that you have replied to the e-mail. This status will be 
synchronized to your Outlook or Notes mailbox, so you can see the 
Replied to status there as well. 
 

Forwarding e-mails 
You can forward an e-mail with all content, including attachments. 

 Forwarding an e-mail 
1. From any folder, open the e-mail. 
2. Open the DME menu, and select Forward or Forward with 

attachments. 
Or: 
1. Long-press an e-mail in a mailbox folder, and select Forward or 

Forward with attachments from the pop-up menu. 
See Sending attachments on page 48 for information about how to 
work with attachments in forwarded e-mails. 
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You can now add recipients, text and attachments, and tap Send to 
send the e-mail. 
For information about how to enter recipients, see Entering 
recipients on page 45. 
If the e-mail you are forwarding was marked with high priority, DME 
will copy this setting to the new e-mail. 
 

Sending attachments 
You can include attachments in e-mails in two different ways: by 
forwarding an e-mail that already contains attachments, or by adding 
attachments from the device to new e-mails (either original e-mails, 
forwarded e-mails, or replies). Furthermore, you can add attachments 
to meeting invitations. 

 Sending attachments in original e-mails and replies 
1. Create an e-mail (see Creating and sending e-mails on page 44 

or Replying to e-mails on page 47). 
2. Select Attachments in the DME menu. 

3. Tap  in the toolbar, and choose if you want to add a file 
(document) or an image. 

 
4. If you chose Files, browse to the file you want to add, and tap it. 

or 
If you chose Images, browse to the album you want, and tap an 
image to add it. You can also start the Camera and take a new 
photo. The screen below will probably look different on your 
device, as it depends on the device manufacturer and your 
software. 
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5. The selected image or file is now shown in the Attachments 

screen. 
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In the Attachments screen, you can tap an attachment to open 
it. You can open it if your device knows a program that can open 
the file (if it recognizes the file's "mime type"). 
Long-press, and select Delete to remove it from the e-mail again. 
Tap Delete all attachments in the DME menu to remove all 
attachments from this e-mail. 

6. Tap  to add another file. 
Tap Back to return to the e-mail. The e-mail now shows that 
attachments were added by displaying a new icon in the top toolbar: 

 You can tap this icon to go to the Attachments screen. 

 Sending attachments in forwarded e-mails 
1. Forward an e-mail (see Forwarding e-mails on page 47). 
2. You can add attachments in the same way as for original e-mails 

(see above). 
or 
If the original e-mail contained one or more attachments, you can 
choose to include these attachments in the forwarded e-mail by 
choosing Forward with attachments. 

3. You can now view, delete, and add attachments by tapping 
Attachments in the DME menu. 

Attachments in forwarded e-mails need not be downloaded to the 
device before they are sent. DME will pull the attachments from the 
collaboration system when the mail is sent, saving transfer costs. 

 Adding attachments to meeting invitations 
1. Create a meeting invitation (see Booking meetings on page 71). 
2. Add attachments in the same way as for original e-mails (see 

above). 
Note that the DME administrator may have blocked for adding new 
attachments from the device to e-mails. Furthermore, restrictions to 
the size of attachments apply. The default maximum size is 16MB, but 
this limit may have been increased or reduced by the DME 
administrator. 
 

Folder actions 
In each mailbox folder, you can perform a number of actions on one 
or more items. 
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Selecting multiple items 
Some functions can be performed on a single item or several, marked 
items - for instance deletion or marking as read. 

To select an item in a mailbox folder or list, tap the Edit icon  in 
the top toolbar. The mailbox shows a grey checkmark icon next to 
each e-mail. Tap the checkmark icon to select the e-mails on which 
you want to perform an action. 

 
Tap Done to exit Edit mode. 
 

Marking read/unread 
When you read an e-mail in the DME client, the e-mail will be marked 
as read - that is, the orange dot  is removed from the e-mail in the 
mailbox folder. Furthermore, the e-mail will be marked as read in the 
collaboration system the next time you synchronize. You can mark an 
e-mail as unread after reading it, for instance in order to remember 
reading it when you get back to the office, or you can mark unread 
e-mails as read. 
The actions described below can apply to a number of selected items. 
See Selecting multiple items on page 51 for information about how 
to select multiple items. 
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 Marking selected or all e-mails as read or unread 
1. In the folder view, select one or more e-mails. 

2. Tap the  icon in the bottom toolbar. 
This will mark all selected items as read if the first selected item 
was unread, and vice versa. 
or 

3. Open the DME menu, and select Actions. 
4. Select Mark selected read to mark the selected e-mail(s) as 

read, or 
Select Mark selected unread to mark the selected e-mail(s) as 
unread, or 
Select Mark all read to mark all e-mail(s) as read, or 
Select Mark all unread to mark all e-mail(s) as unread. 

Note that the Mark all read/unread options are also available for 
one e-mail at a time if you long-press an e-mail in the mailbox view. 
 

Deleting items 
When deleting an e-mail, the e-mail data is removed from the DME 
client. Depending on an e-mail setting, the e-mail can also be deleted 
on the mail system at the next synchronization (see E-mail settings 
on page 104). 
The actions described below can apply to a number of selected items. 
See Selecting multiple items on page 51 for information about how 
to select multiple items. 

 Deleting one or more selected items 
1. Select the item or items to be deleted. 

2. Tap  in the bottom toolbar. 

or 
Open the DME menu, and select Actions > Delete selected. 

3. Tap Yes to confirm the deletion. 
Note that DME will try to prevent the accidental deletion of many 
items. If you delete a large number of items (more than 20 
e-mails/meeting invitations or more than 10 contacts) at a time, a 
message will ask you if you really want to delete the items on the 
server, the next time the device synchronizes with the server. 

 Deleting a single e-mail 
1. In the folder view, long-press the e-mail you want to delete. 
2. Select Delete in the popup menu. 
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 Deleting the currently open e-mail 
1. Open the DME menu in the e-mail you are reading, and select 

Delete, or 

Tap . 

2. Tap Yes to confirm the deletion. 
 

Toggling follow-up flag 
You can set or remove a follow-up flag on your e-mails. E-mails 
marked with a follow-up flag have a special status in the collaboration 
system. In Outlook, for instance, they are automatically listed in your 
Tasks pane. 
The actions described below can apply to a number of selected items. 
See Selecting multiple items on page 51 for information about how 
to select multiple items. 

 Setting or removing follow-up flag 
1. In the folder view, select one or more e-mails. 

2. Tap the  icon in the bottom toolbar. 
This will flag all selected items if the first selected item was 
unflagged, and vice versa. 
or 

3. Open the DME menu, and select Actions. 
4. Select Flag to flag the selected e-mail(s), or 

Select Clear flag to clear the flag from the selected e-mail(s). 
Note that the Flag/Clear flag options are also available for one 
e-mail at a time if you long-press an e-mail in the mailbox view. 
To change the follow-up flag for an e-mail you are currently viewing, 
select More > Flag or Clear flag in the DME menu. 
The follow-up status is updated in the collaboration system after your 
next synchronization. 
 

Moving to other folders 
You can move one or more e-mails to other folders. The next time 
you synchronize, the e-mails will be moved on the collaboration 
system as well. 
The actions described below can apply to a number of selected items. 
See Selecting multiple items on page 51 for information about how 
to select multiple items. 

 Moving selected e-mails to another folder 
1. In the folder view, select one or more e-mails. 
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2. Tap the  icon in the bottom toolbar. 
A list of your folders is shown.  

 
Browse to the folder to which you want to move the e-mail(s), 
and tap OK. 

The e-mails are moved to the selected folder. Note that the Move to 
folder option is also available for one e-mail at a time if you 
long-press an e-mail in the mailbox view, or from an open e-mail. 
 

Search 

Using the DME client you can search for contacts in the global 
address book on the collaboration system, search e-mails in your 
mailbox on the collaboration system, or search e-mails already 
downloaded to the device. 
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Global Address Book 
The Global Address Book is the shared address book on the 
collaboration system as set up by the network administrators. 
To create an e-mail message or a meeting invitation, you can open the 
DME menu and select Create as described in Creating and sending 
e-mails on page 44 or Booking meetings on page 71. However, you 
can also find the recipient or recipients of your e-mail or meeting 
invitation first, and then choose to create a new e-mail or meeting 
with the selected contacts as recipients. 

 Finding contacts in the global address book 
1. From the Desktop or in a mailbox folder, open the DME menu, 

and tap Search > Global Address Book. 
You can now search for a contact by Name, E-mail address, 
Department, Country, or Title. 
Note that more fields or different fields may be available if the 
Global Address Book search screen has been customized. See 
separate documentation about customizing the fields in this 
screen. 

2. Enter a search text in at least one of the available fields, and tap 
Search.  
A connection is made to the collaboration system, and the search 
results are displayed. Depending on a setting on the DME server, 
the search will either look for entries starting with the text you 
have entered, or entries containing the text you have entered. 
When searching for a name, you can enter both a first and last 
name separated with a space. 
By default a maximum of 10 results are shown, but this value can 
be changed by the DME administrator. 
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From the search results, you can select contacts the same way as with 
your local contacts. Selected contacts are marked with a . You can 
now perform a number of functions with one or more of the found 
contacts. 
1. Create new e-mail or meeting: Open the DME menu (or long-press a 

contact), and then tap Create > E-mail or Meeting to insert the 
selected contacts as recipients in a new e-mail or as participants in 
a new meeting, respectively. 



DME Client User Guide 4.0 
User guide: Android devices 

 

57  © 2012 Excitor 
 

2. View details: Tap a contact to view more details about the contact. 
The details are shown as a list. The amount of information 
depends on how many details have been made available by the 
collaboration system. Note that tapping an Address field opens 
the contact's address in Google Maps. Press Back to close the 
details window. 

 
3. Place a call: You can place a call to a contact by long-pressing the 

contact and tapping Call. Any phone numbers associated with the 
highlighted contact are listed. Tap one to place a voice call to the 
contact, or tap Back to exit the menu. 

4. Add to contacts: Select one or more contacts, and tap Add to 
contacts in the DME menu. The selected contact or contacts are 
added to the device Phonebook. Depending on your version of 
Android, the contacts are added in the main phonebook or in a 
contact group called DME. Note that due to bug in Samsung 
Galaxy, contacts are added to a group called Unknown on that 
device. 

DME responds with a message:  when 
done. 

Finally, you can choose New search in the DME menu to return to 
the search screen with every option in the search screen reset to 
default values. 



DME Client User Guide 4.0 
User guide: Android devices 

 

58  © 2012 Excitor 
 

 

E-mails (on server) 
The DME client only synchronizes e-mails from the last number of 
days specified in the e-mail settings (see E-mail settings on page 104). 
This is called the e-mail synchronization window. Sometimes you may 
need to find an e-mail which is stored in a folder in your collaboration 
system mailbox which is not synchronized to the DME client, or 
which is too old to be synchronized to the client. 
Using this function, you can search for any e-mail stored in any folder 
of your mailbox on the collaboration system. 

 Searching for e-mails on the server 
1. From the Desktop or in a mailbox folder, open the DME menu, 

and tap Search > E-mails (on server). 
2. Complete the search fields in the form: 

 
1. Search text: In this field enter the text to search for. 
2. Field: Select the e-mail fields in which to search for the 

specified text. Tap to choose between the following options: 
Any field: All fields in an e-mail are searched for the specified 
text string. 
Subject: Only the Subject field is searched. 
Subject, body: Both the Subject and the Body fields are 
searched. 

3. Person: In this field enter all or part of the name of the 
sender of the e-mail you are looking for (or recipient in case 
you are searching your Sent folder). 
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4. Folder: Choose the folder in which the e-mails to be searched 
are located. Tap to choose among the mail folders defined in 
the mailbox on the collaboration system, or choose All 
folders. 

5. Date: In the two fields Start and End you can select a range 
of dates. This limits the search to e-mails received within the 
selected time frame. If you only select a start date, e-mails are 
searched from that date up until today. If you only select an 
end date, e-mails are searched from the distant past up until 
that date. 

3. Tap Search. 
Note that a search can only be executed if one or more of the fields 
Search text, Person, Folder, or Date has been completed. If not 
completed, an error message says "Search fields cannot be blank" 
when you execute the search. 
After a while, the search results are displayed in a Search screen. 
When you tap a found e-mail, it is retrieved from the server, and 
shown as a regular e-mail, and you can perform all the regular e-mail 
functions (reply or forward, or view more details about the e-mail). 
If no results are found, DME shows a message that no matches are 
found, and you are returned to the search screen after confirming the 
message. 
If you did not find the e-mail you were looking for, select New 
search in the DME menu to try again. 
Press Back to return to the Desktop. 
 

Technical details 
Note that the client shows the results in the order in which they are 
presented by the collaboration system. If your collaboration system is 
based on Lotus Domino, the search results are returned in order of 
relevance. If your collaboration system is based on Microsoft 
Exchange, the search results are returned in chronological order (that 
is, by date). 
The server sets a limit to the number of search results. By default, the 
limit is 100 results. 
Please note that for best performance, your mailbox should be 
indexed. For more information about indexing your mailbox, see the 
documentation for Lotus Notes or Microsoft Outlook. 
Note also that if you select a folder which contains other folders, you 
will get different results depending on your collaboration system: 
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 If you use Domino, the search for e-mails will be performed in the 
selected folder only. 

 If you use Exchange, a message will be shown: "Do you wish to 
include subfolders in your search?" If you answer Yes, e-mails in 
the subfolders of the selected folder will be searched as well. 

 

E-mails (on phone) 
From any folder, you can search for a text string contained in an 
e-mail in DME. 

 Searching for an e-mail locally 
1. From the Desktop or in a mailbox folder, open the DME menu, 

and tap Search > E-mails (on phone). 
2. Complete the search fields in the form. The form is identical to 

the E-mails (on server) form - see E-mails (on server) on page 58. 
3. Tap Search. 

Note that a search can only be executed if you have entered a 
search text in the Search text field. 

The search results are displayed in a Search screen. You can open 
the found e-mails as regular e-mails, and all the usual features are 
available. After reading the e-mail, press Back to return to the search 
results. 
If no results are found, DME shows a message that no matches are 
found, and you are returned to the search screen after confirming the 
message. 
To perform a new search, tap New search in the DME menu. 
Press Back to return to the Desktop. 
 

Calendar 

DME contains a complete, built-in calendar, which you can use to get 
an overview of your appointments. Meeting invitations from other 
people are received in the DME Inbox, and are transferred to the 
calendar when you accept them. 
From the calendar, you can create new meetings and invite other 
people to the meetings. You can respond to meetings by accepting, 
declining, delegating or proposing a new time for the meeting. 
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Meetings that you create for yourself (personal appointments) are 
saved directly in the Calendar. Meetings with other participants are 
also saved directly in your Calendar, and are sent as invitations to the 
other participants (and resources) at the next calendar 
synchronization. 
The DME calendar requires that calendar synchronization is enabled. 
See Calendar sync. settings. 
 

Calendar views 

To view the calendar entries in the DME calendar, select the  
icon from the Desktop, or select View > Calendar in the DME 
menu. 
The calendar opens on today's date in the Month view. You can 
choose to see your calendar entries in four different views: 
 Day view: See all calendar entries for one day. Browse to the 

previous or next day by swiping left or right. The title text tells 
you the date of the day you are currently viewing. 

 
 Week view: See all calendar entries for one week. Browse to the 

previous or next week by swiping left or right. The text below the 
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title (which is the month) tells you the number of the week you 
are currently viewing. 
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 Month view: See all calendar entries for one month. Browse to 
the previous or next month by swiping the month calendar 
control left or right. The title text tells you the name of the month 
and the year you are currently viewing. For each calendar entry on 
the selected date, the month name, date, time, and subject of the 
entry are shown. 

 
Each view can be seen in landscape mode as well. Below is the 
Month view in landscape rotation. 
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 List view: See all calendar entries as a long list. 

 
To switch views, tap the icons in the top part of the screen. 
To open a meeting, tap it from any view. 
 

Go to date 
To show a certain date in the DME calendar, select Go to date in 
the DME menu. Enter the desired date by tapping or long-pressing the 
+ and - icons in the date spinner. Select Set to go to the selected 
date. The date will be shown in the current view. 

 
To go to today's date, select Go to today in the DME menu. 
 

Calendar actions 
From each view, you can select the following actions: 
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 Create meeting: Tap the  button to create a new meeting 
(or tap Create in the DME menu). The default date set for the 
new meeting is the currently viewed day. In the Week view and 
the Month view, the meeting date is set to the first day within 
the viewed range of days, for instance the first in the month 
currently viewed. If that date has passed, today's date is suggested 
as the meeting date. See Booking meetings on page 71. 

 Synchronize: Perform a manual calendar synchronization by 
tapping Synchronize in the DME menu. See Synchronization 
overview on page 13 for more information. 

 

Viewing and editing meetings 
To view details about a meeting in the calendar, tap to open it. You 
can now see all the fields that have been completed for this meeting, 
but you cannot initially change any fields. 
Your options in the DME menu depend on whether you organized the 
meeting in question (you are the chair) or you were invited as a 
participant. 

 Calendar options for the meeting chair 
If you are the chair of the meeting, the following options are available 
in the DME menu: 
 Edit: Select this option if you want to change any of the details in 

the meeting, including removing and adding participants. All fields 
in the meeting invitation are now opened, and you can make any 
change you want. 
Note: The Domino collaboration system permits the use of 
formatted text and the embedding of attachments in the meeting 
description. If the meeting description contains attachments, you 
will not be able to edit the description on the device. If there are 
no attachments, and you edit the Description field on the device, 
any formatting and any embedded objects in the field will be lost 
when the calendar event is synchronized back to the collaboration 
system. 
Select Attachments in the DME menu to add or remove 
attachments in the meeting. See Sending attachments on page 

48. an attachment icon  is shown in the top toolbar if the 
meeting has attachments. 
When you are done editing the meeting, you may select Check 
free time in the DME menu to verify that all participants are free 
at the time in question, if you have changed the meeting time or 
date. For more information, see Checking free time on page 77. 



DME Client User Guide 4.0 
User guide: Android devices 

 

66  © 2012 Excitor 
 

Select Save in the DME menu to save your changes. You are 
prompted to enter a comment about the reason for changing the 
meeting, which is sent to each participant when you synchronize. If 
you remove a participant from the list of required participants, the 
participant receives a meeting cancelation notice, and the meeting 
will be removed from the calendar of that participant. 

 Reschedule: This option is available if you are the chair, and you 
have invited other people to the meeting. Select this option if you 
want to move the meeting to another date or time. A new screen 
opens, letting you set a new date and time for the meeting. 

 
Change the date and time. You may now select Check free time 
in the DME menu to verify that all participants are free at the time 
in question. For more information, see Checking free time on 
page 77. 
Select Save in the DME menu to save your changes. You are 
prompted to enter a comment about the reason for rescheduling 
the meeting, which is sent to each participant when you 
synchronize. 

 Cancel meeting: This option is available if you are the chair, and 
you have invited other people to the meeting. Select this option if 
you want to cancel and delete the meeting. The meeting will be 
removed from the calendar of all participants. You are prompted 
to enter a comment about the reason for canceling the meeting, 
which is sent to each participant when you synchronize. 
Note: If your collaboration system is Exchange 2003, DME is 
unable to process meeting cancelation notices. This means that if 
you receive a notice about a canceled meeting, you must accept 
the cancelation in Outlook or Outlook Web Access (the OWA 
webmail). 

 Delete: This option is available if you are the chair, and you have 
not invited other people to the meeting (it is a personal 
appointment or similar). Select this option if you want to cancel 
and delete the appointment. The appointment will be removed 
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from your calendar in DME immediately, and from your 
collaboration system when you synchronize. 

When you save any changes, DME asks you if you want to synchronize 
the calendar immediately. 

 Calendar options for meeting participants 
If you are a participant in the meeting, and not the chair, the following 
options are available: 
 Edit: Select this option if you want to change details in the 

meeting. As a participant, you only have access to toggle the 
Private status of the meeting and the Alarm (and possibly set the 
alarm time). After editing these fields, select Save in the DME 
menu to save your changes. 

 Decline 
 Propose new time 
 Delegate: For information about these three options, see 

Responding to meeting invitations on page 67. Note that 
selecting Decline or Delegate removes the calendar entry from 
the calendar immediately. 

After making any changes, DME asks you if you want to synchronize 
the calendar. 
 

Responding to meeting invitations 
When meetings are booked on the collaboration system, all invited 
participants receive a meeting invitation by e-mail, containing 
information about the meeting. 
In the DME client, a meeting invitation is recognized by a calendar 

icon  in the Inbox. See E-mail on page 35 for more information. 
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 Responding to a meeting invitation 
1. Open the meeting invitation. You can now see the subject and 

time of the meeting, who organized the meeting, who have been 
invited (participants), and any information about location and 
resources involved in the meeting. 

 
The three most commonly used response options are shown as 
buttons along the bottom of the screen: Accept, Tentative, and 
Decline. See below for more information about these and other 
options. 

2. In the DME menu, you can now choose among a number of 
options. Most of the options are available on all supported 
collaboration systems, but there may be differences, which are 
noted below.  
Furthermore, the description of the actions pertain to the 
standard way of inviting to meetings. For instance, in Domino the 
chair can select options in the meeting invitation in Notes 
specifying that he or she does not want to receive responses from 
invitees (participants), wants to prevent counter-proposals, or 
wants to prevent delegation. Such options are naturally observed 
by DME, even if they are not mentioned in the descriptions below. 
The following options may be available in the DME menu: 
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 Accept: Accept the meeting invitation. The meeting is created 
in the calendar, and a notification of your acceptance is sent to 
the meeting organizer/chair. 

 Decline: Decline the meeting invitation. Notification of this is 
sent to the organizer/chair and any other participants. 

 Tentatively accept: If you want to attend the meeting, but 
you are not sure that you are available at the proposed time, 
you can tentatively accept the meeting. This way the meeting is 
booked in your calendar, but the time still appears free for 
other users. Note: On Exchange 2003 systems, this action is 
not available for recurring meetings. 

 Propose new time: If you would like to attend, but you are 
not available at the proposed time, you can propose a new 
time (also called countering the meeting proposal). Selecting 
this option opens a new screen in which you can select a new 
time, date, and time zone for the meeting. 

 
When you are done, tap OK to send the new proposed time, 
or tap Check free time in the DME menu to see if the new 
proposal conflicts with the calendars of any of the required 
participants. For more information, see Checking free time on 
page 77. When you send the new proposed time, the meeting 
chair/organizer will receive an e-mail with the subject 
Countered: and the subject of the meeting. 
Please note that once the calendar entry has been accepted, 
you are not able to change the time zone of the calendar entry 
if you subsequently edit the calendar entry from your calendar 
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to propose a new time. Note: On Exchange 2003 systems, this 
action is not available for recurring meetings. 

 Delegate: If you are unable to attend the meeting, you may 
want to send someone else in your stead. Choose Delegate, 
and select another user from your local or global address 
book. The Delegate field functions as other recipient fields, 
with type-ahead selection of recipients and the ability to 
choose from the local and global address books. See Entering 
recipients on page 45 for more information. 

 Show calendar: Open your DME calendar on the day of the 
meeting so you can check your schedule for that day. Select 
Back to return to the meeting invitation. 

 Delete: Delete the current meeting invitation without 
performing any action with it. To get the meeting invitation 
back into your mailbox, you must synchronize your e-mail. 
Note, however, that if the option Delete only locally is set 
to No in E-mail settings (see E-mail settings on page 104), 
the invitation will be deleted on the server also at the next 
synchronization. Note: On Exchange 2003 systems, this action 
is not available for recurring meetings. 

3. When you accept, decline, tentatively accept, propose a new time, 
or delegate a meeting invitation, you are given the option to add a 
comment. If you enter a comment, it is sent to the organizer/chair. 
Select OK to complete the action, or press Back to return to the 
meeting invitation without making changes. Note: On Exchange 
2003 systems, not all actions allow you to reply with comments. 

4. When you respond to a meeting invitation by using any of the 
above actions, the e-mail containing the invitation is removed from 
your Inbox, and if you accepted the meeting, your calendar is 
updated on the collaboration system at the next calendar 
synchronization. 

 

Recurring meetings 
Recurring meetings created on the collaboration system are 
synchronized to DME as a series of individual appointments. This 
means that if you edit one in a series of meetings, only that instance 
of the meeting series will be changed. If you want to edit the entire 
series, you must do so in Microsoft Outlook or Lotus Notes. 
Recurring meetings created on the device are sent to the server as a 
true series of recurring meetings, not as individual events. If you 
create a recurring meeting on the device without an end date, the 
DME server will add an end date automatically. The end date will be 
five years in the future. 
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Booking meetings 
You can book meetings in your corporate calendar from the DME 
client. You can invite people to attend the meeting, and you can 
reserve rooms and resources. This basically works the same way as 
booking meetings in your collaboration system. 

 Creating a new meeting 
1. To create a new meeting, select Create > Meeting in the DME 

menu from the Desktop or a mailbox folder. 
or 

From the Calendar, select Create in the DME menu, or tap . 

2. Enter meeting details: see Entering meeting details on page 72. 
3. Enter a location and book resources: see Location and resources. 
4. Check to see if the calendars of all participants are free at the 

proposed time: see Checking free time on page 77. 
5. Add attachments: see Sending attachments on page 48. 
6. From the DME menu, select Save. 
The meeting is created in your calendar. Meeting invitations are sent 
to the selected participants and resources at the next calendar 
synchronization, which is governed by the setting Send 
immediately. If this setting is Send or Send & Receive, your 
calendar is synchronized immediately. See E-mail settings on page 
104. 
Note that you can create a new meeting invitation by selecting 
recipients first from a search and then creating the meeting 
invitations. For more information, see Global Address Book on page 
55. 
During the creation of a meeting, you can also choose Save as draft 
in the DME menu or Close. Selecting Save as draft saves the 
meeting as a draft, allowing you to interrupt your work on the 
meeting proposal for a later time. The Close option closes the 
current meeting draft, and prompts you if you want to save it as a 
draft before closing it.  
The meeting is shown in your calendar as a regular meeting, but with 
a blue, hollow triangle on top of it, and it will not be synchronized to 
the collaboration system. Please note that draft meetings are not 
synchronized with the server. This means that if you import your 
calendar from the server, any draft meetings in your DME calendar on 
the device will be lost. 
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Entering meeting details 
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The Meeting details tab contains the following fields: 
 Subject: Enter a subject for the meeting. 
 Location: Here you can enter free text describing the location of 

the meeting - for instance an office, a country or a city. If you 
enter an address, DME automatically inserts a map marker. For 
more information, see Contacts and addresses on page 90. 

 Rooms: Here you can select one or more of the rooms available 
in the collaboration system. See Rooms and resources on page 
74. 

 Date and time: Enter starting and ending dates and times for the 
meeting. If you select the field All day, the event changes to an 
all-day event, and you can only choose a date. 

 Time zone: In this field you select the time zone of the location 
where the meeting is held. For instance, if you are based in 
Copenhagen, but want to call a meeting at 2 PM in London, you 
should enter 2 PM as the meeting start time, and Europe/London 
in this field. This way, the meeting will be placed correctly in your 
calendar - which is at 3 PM in local Copenhagen time. When you 
travel to London, and the phone changes time zone, it will be 
shown correctly in the calendar at 2 PM, London time. 
Use the search box at the top of the screen to search for your 
time zone. 

 All day: Mark the meeting as an all-day meeting. When you select 
this field, you cannot enter start and times for the meeting. The 
meaning of "all-day" depends on which collaboration system you 
are using: 

 All-day events in Lotus Domino do not support the use of 
other participants, rooms, or resources. An all-day event created 
in Domino will only display a Details tab and a Location tab 
when it is synchronized to the client - it is not possible to add 
participants and resources to the event. 
When you create an all-day event on the client, you are able to 
add participants etc. to the event. However, when the event is 
synchronized to the server, it is created in Domino as a regular 
meeting, and the client will reflect this also (even though the All 
day field is still checked). 

 In Microsoft Exchange, you are able to invite participants 
and book resources for all-day events - the All day field simply 
signifies that the event has no time constraints. 

 Private: Mark the meeting as private. This means the the meeting 
details are not visible to other people in the collaboration system 
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when you sync the calendar item, but your time will appear 
booked. 

 Alarm: Set the alarm time to one of a list of fixed alarm times. 
Disable the alarm by setting the alarm time to None. 

 Participants: In the Participants fields, you can add meeting 
participants from Local contacts on the device and from the 
global address book on the server. You can enter Required 
participants, Optional participants (Cc), and FYI 
participants (Bcc). 
Click one of the Participants fields. The field functions as other 
recipient fields, with type-ahead selection of recipients and the 
ability to choose from the local and global address books. See 
Entering recipients on page 45 for more information. 
See Global Address Book on page 55 for information about 
selecting participants before creating the meeting. Participants 
selected from a Global Address Book search result are added to 
the Required participants field. 
Tap Check free time in the DME menu to see if all required 
participants are free. See Checking free time on page 77. 

 Resources: Here you can select one or more of the rooms 
available in the collaboration system. See Rooms and resources 
on page 74. 

 Description: Enter a description of the meeting, agenda, etc. 
Tap Attachments in the DME menu to add attachments to the 
meeting invitation. See Sending attachments on page 48. 
Tap Save to save the meeting to your calendar and send it to all 
participants. 
 

Rooms and resources 
In the Event detail screen, you can book rooms and resources that 
are available in the collaboration system. 
In the form, you can enter information into the following fields: 
Before selecting rooms or resources, you must download the 
available rooms and resources from the collaboration system to your 
device. 

 Downloading rooms and resources 
The first time you click either of the Rooms or Resources fields, 
DME will download a list of rooms and resources from the server. 
Subsequently, you can refresh the list of resources by selecting 
Update in the DME menu. 
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 Selecting rooms and resources 
1. Tap the Rooms or Resources field. 
2. Open the drop-down list by tapping a name. 
3. You may have to select which site you want to select your rooms 

and resources from by clicking it. This depends on your 
organization's directory configuration. If your organization only 
uses one site, the list of rooms or resources is shown directly. 

4. Scroll up and down in the list of rooms or resources, and mark 
the rooms or resources you want to add. Note that if the people 
capacity of the room is entered in the collaboration system, it is 
shown in the list. 
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5. Tap Done. 

The selected rooms or resources are entered into the field in 
question. 

To unselect a room or resource again, repeat the above process, and 
unmark the room or resource you want to omit before tapping 
Done. 
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Checking free time 
When participants, rooms and resources have been added, you can 
check if they are available within the specified time frame. This can be 
done from any of the tabs. 

 Checking free time 
1. Open the DME menu, and select Check free time. 

After DME has checked on the server, you will see a message 
indicating whether all participants and resources are available or 
unavailable within the selected time frame. 

 
2. Select Yes to show alternative time frames 

or 
Select No to keep the current time frame. 
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If you select Yes to show alternatives, you will see a list of time 
frames within which all participants and resources are available. 

 
3. Scroll up or down to select a new time frame. 

4. Tap the time frame you want to use (Android) 
The meeting details are changed to reflect the update. 
 

Contacts 

DME can keep the contacts in your Personal Address Book in Lotus 
Notes or Microsoft Outlook synchronized with contacts on your 
device. DME contains a secure, internal address book - the DME 
Address Book. If the setting Contacts sync. is enabled (see Contacts 
sync. settings on page 108), your contacts in the collaboration system 
will be kept in sync with the contacts in DME. 
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Furthermore, you can choose to synchronize your DME contacts with 
the contacts in the native Contacts application. This way, all your 
contacts - both business and personal - can be maintained in either 
DME or in the Contacts application. Or you can choose to keep your 
business contacts in the DME Address Book and your private contacts 
in Contacts - for reasons of security, work/life balance, or both. For 
more information, see Contacts sync. settings on page 108. 
Whenever you create an e-mail or book a meeting, you can choose 
recipients from the Global Address Book or from your local contacts. 
See Entering recipients on page 45 for more information. 
For information about importing contacts to the device from the 
collaboration system, see Initial import and reset on page 16. For 
information about synchronizing contacts with the collaboration system, 
see Synchronization overview on page 13. 
The DME contact synchronization works differently on different 
versions of Android. The section Adding and editing contacts on 
page 83 describes the creation and editing of contacts on Android 
1.5/1.6 devices, Android 2.1 devices, and Android 2.2+ devices. 
When you have added, edited, or deleted one or more contacts, your 
changes are synchronized to the collaboration system at the next 
scheduled or manual sync, or when the DME server initiates a contact 
sync. 
 

Using contacts 

To view your local contacts, tap  on the Desktop. 

The list of contacts in your DME address book is shown. 

 
Flick through the list to find the contact you need. 
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Or start typing in the Search field. The list of contacts will shrink as 
you type. Press the Back button to remove the keyboard and show 
the results. Delete the search text to show all contacts again. 

 
When you find the contact you need, tap it. 

 
You can now tap any of the fields to use the information in the field: 
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 Tapping a Phone field lets you create an SMS message to the 
contact, or place a call to the contact. 

 
 Tapping an E-mail field lets you create an e-mail for the contact, or 

book a meeting with the contact. 

 
 Tapping a Website field opens the link in the browser app. 
 Tapping an Address field opens the address location in Google 

Maps. See Contacts and addresses on page 90. 
 

Interaction with the device Contacts 
As mentioned previously, the DME Contacts may be integrated with 
the contacts application which is native to your device. This depends 
on a security option in Contacts settings (note: requires DME 
Server 3.5 minimum). 
The security setting is found in the Device Address Book section, 
and has three options: 
 Copy all fields (a.k.a. Open mode) 

In Open mode, contacts created on the collaboration system or 
in the DME Contacts are also shown in the native contacts.  
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Contacts created and edited from the native contacts application 
are synchronized with your collaboration system. 
The contacts are placed in a separate DME group (see Adding and 
editing contacts on page 83). Contacts synchronized with 3rd 
party services, such as Google or Facebook, will not affect this 
group. However, please note that if you aggregate contacts (linking 
contact info for the same people in different contact groups), this 
aggregation will be lost if you should re-import your contacts from 
the collaboration system. 

 Copy name and phone numbers (a.k.a Mixed mode) 
In Mixed mode, contacts created on the collaboration system or 
in the DME Contacts are also shown in the native contacts. 
However, any potentially sensitive information is replaced by a 
message from DME. The only data shown in the native contacts 
app are the name and phone number. Any other data are hidden, 
and the fields are empty in the native contacts app. 
Personal contacts created from the native contacts application will 
be secured after synchronizing with the collaboration system. 

 Don't use (a.k.a. Secure mode) 
In Secure mode, all contacts created on the collaboration system 
or in the DME Contacts are kept in DME. There is no interaction 
with the native contacts. 
Personal contacts created from the native contacts application are 
not synchronized with the collaboration system. 

See also Contacts sync. settings on page 108. 
 

Switching contact modes 
If you switch the contacts mode, DME will process your contacts 
immediately. 
 Switching from Open/Mixed to Secure mode: 

All native contacts are merged into the DME Contacts, and are 
the device DME contact group is then removed. Any contacts that 
you subsequently create in the native contacts will remain there 
and will not be synchronized with the collaboration system, as 
there is no longer any interaction with the DME Contacts. 
To merge the contacts, DME sends all your native contacts to the 
server. The server then checks against the collaboration system to 
weed out any duplicates (contacts that exist both locally on your 
device and in your personal address book on the server). All 
non-duplicates are added to your personal address book on the 
server. If DME cannot reliably determine whether a contact is a 
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duplicate or not, it is added with a number after the name. Your 
contacts are then imported into the DME Contacts, and the 
process is complete. 

 Switching from Secure to Open/Mixed mode: 
Your contacts from the DME Contacts are made visible in the 
DME contact group. 

 

Adding and editing contacts 
Different contact applications on different phones and phone 
platforms support different contact fields. A contact field is for 
instance the First name field or the Telephone field in a contact. 
When synchronizing the address book in MS Outlook or Lotus Notes 
to a mobile device, different third-party applications may map the 
fields in Outlook/Lotus Notes to the phone in different ways. 
The DME Address Book supports a large, but fixed number of fields. 
By using DME for synchronizing contacts, you can be certain that 
everybody in the organization maps contacts from the collaboration 
system to their device in the same way. 

When you select Create  or Edit in the menu of the DME 
Address Book, DME lets you enter information into the following 
fields: 
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Account name 
Anniversary 
Assistant 
Assistant phone 
Birthday 
Carphone 
Categories 
Children 
City 
City (business) 
City (home) 
Company 
Company phone 
Country/Region 
Ctry./Reg. (bus.) 
Ctry./Reg. (home) 
Customer ID 
DTMF 
Department 
E-mail 
E-mail (business) 
E-mail (home) 
Extension 
Extension (bus.) 
Extension (home) 
Fax 

Fax (business) 
Fax (home) 
File as 
First name 
Government ID 
IM ID 
IM ID 2 
IM ID 3 
Internet tel. (bus.) 
Internet tel. (home) 
Internet telephone 
Job title 
Last name 
Location 
Manager 
Middle name 
Mobile 
Mobile (business) 
Mobile (home) 
Nickname 
Note 
P.O. Box 
P.O. Box (bus.) 
P.O. Box (home) 
Pager 
Postal/ZIP code 

Postal/Zip (bus.) 
Postal/Zip (home) 
Push to talk 
Radio phone 
SIP 
Share view 
Spouse 
St./Prov. (bus.) 
St./Prov. (home) 
State/Province 
Street 
Street (business) 
Street (home) 
Suffix 
Tel. (business) 
Tel. (home) 
Tel.2 (business) 
Tel.2 (home) 
Telephone 
Title 
Video call 
Video call (bus.) 
Video call (home) 
Web addr. (bus.) 
Web addr. (home) 
Web address 

Note that adding contacts in the native phonebook of the device is 
different on different versions of Android. The descriptions below are 
relevant to DME if your Device Address Book setting is Open or 
Mixed (see Contacts sync. settings on page 108). 
 

Contacts on Android 1.5/1.6 devices 

 Adding contacts: Android 1.5/1.6 
1. Open the native Android 1.5/1.6 Contacts (or: Phonebook) 

application. 
2. In the Contacts menu, tap New contact. 
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You are prompted to complete the action using one of two 
methods: 

 
3. Tap Create DME contact. 

If you mainly use DME for managing your contacts, you can select 
the checkbox Use by default for this action. 

4. The Add Contact screen in DME opens. Now complete the 
fields in the new contact. For information about the available 
fields, see Adding and editing contacts on page 83. 

 
5. Tap Save when you are done. 
Your new contact is now ready to be synchronized to the 
collaboration system. 

 Editing contacts 
Open the native Contacts application. 

1. Find the contact you want to edit. Open the contact, and tap Edit. 

 
2. Tap Edit DME contact.  

The contact is opened in the DME Contacts.  
3. Edit the contact, and save it. 
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You should always choose to edit DME contacts using the DME 
account to avoid issues with unsupported fields etc. 

Your contact is now ready to be synchronized to the collaboration 
system. 
 

Contacts on Android 2.1 devices 

 Adding contacts: Android 2.1 
1. Open the native Android 2.1 Contacts application. 
2. In the Contacts menu, tap New contact.  

You are prompted to complete the action using one of two 
methods: 

 
3. Tap Create DME contact. 

If you mainly use DME for managing your contacts, you can select 
the checkbox Use by default for this action. 

4. The Add Contact screen in DME opens. Now complete the 
fields in the new contact. For information about the available 
fields, see Adding and editing contacts on page 83. 

 
5. Tap Save when you are done. 

The new contact is now saved under the DME account, meaning 
that it will be managed by DME. 
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If, in step 2 above, you chose to add the contact using the Create 
contact action, you would still be able to create it under the DME 
account by choosing Phone (DME) when saving the contact: 

 
Please note that the Samsung Galaxy S incorrectly creates an account 
called Unknown (DME) (instead of Phone (DME)) after import or 
synchronization. 
Your new contact is now ready to be synchronized to the 
collaboration system. 

 Editing contacts 
Open the native Contacts application. 

1. Find the contact you want to edit. Open the contact, and tap Edit. 

 
2. Tap Edit DME contact.  

The contact is opened in the DME Contacts.  
3. Edit the contact, and save it. 

You should always choose to edit DME contacts using the DME 
account to avoid issues with unsupported fields etc. 
Your contact is now ready to be synchronized to the 
collaboration system. 
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Contacts on Android 2.2 devices or later 

 Adding contacts: Android 2.2 or later 

1. Click the Contacts icon  on the Desktop in DME. 
The native Android 2.2 Contacts application is shown. 

2. In the Contacts menu, tap New contact.  
You are prompted to complete the action using one of two 
methods: 

 
3. Tap Create DME contact. 

If you mainly use DME for managing your contacts, you can select 
the checkbox Use by default for this action. 

4. The Add Contact screen in DME opens. Now complete the 
fields in the new contact. For information about the available 
fields, see Adding and editing contacts on page 83. 

 
5. Tap Save when you are done. 

The new contact is now saved under the DME account, meaning 
that it will be managed by DME. 



DME Client User Guide 4.0 
User guide: Android devices 

 

89  © 2012 Excitor 
 

If, in step 2 above, you chose to add the contact using the People 
action, you would still be able to create it under the DME account by 
choosing DME in the Group field before saving the contact: 

 
Even though the interface calls this a group, it really is the account. 
Your new contact is now ready to be synchronized to the 
collaboration system. 

 Editing contacts 
Open the native Contacts application. 

1. Find the contact you want to edit. Open the contact, and tap Edit. 

 
2. Tap Edit DME contact.  

The contact is opened in the DME Contacts.  
3. Edit the contact, and save it. 
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You should always choose to edit DME contacts using the DME 
account to avoid issues with unsupported fields etc. 

Your contact is now ready to be synchronized to the collaboration 
system. 
 

Initial import of contacts on Android 2.x 
After importing contacts for the very first time, you can see them by 

tapping  from the Desktop, and use them as recipients in 
new e-mails or participants in new meetings. 
However, you may be surprised to find that if you open the native 
Contacts application on your Android device, you cannot see the 
contacts you imported from DME. This is because you need to set up 
your device to add the DME contacts to the group of visible contacts. 

 Viewing DME contacts in native contacts application 
1. Open the native contacts application. Depending on your phone, it 

may be called Contacts, People, or Phonebook. 
2. Add the DME account or group to the contacts displayed. This is 

done in different ways depending on your phone, for instance: 
On Sony Ericsson X10 phones, tap the Group icon at the top left 
of the Phonebook screen. 
On HTC Desire, choose Menu > View. 
On Samsung Galaxy and Google Nexus One, choose Menu > 
Display options. 

3. Tap the group or account called Phone (DME) (or similar). 
4. Select the All Contacts checkbox (or similar). 
5. Tap OK. 
Your DME contacts should now be visible in your native Contacts 
application, and available to the Phone and other apps. 
 

Contacts and addresses 
If the Address tab of a contact has been completed, DME 
automatically inserts a link to Google Maps (or another Map 
application) to help you locate the contact. To see this, open a 
contact from your DME Contacts, and tap the Address tab. 
A map marker is placed within the Street field. Tap the marker to 
open Google Maps and find the address. 
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The same applies if the Location field in a meeting is completed with 
an address. 
 

Work/home scheme 
Some of the fields in the DME Address Book mentioned above are 
special in that they function as a sort of alias for up to three distinct 
fields. An example of this is the field Mobile. When you enter a 
number into the Mobile field and synchronize, then how can DME 
know if the number should be placed in the Cell phone, Mobile, or 
Mobile 2 in Lotus Notes, or in Business Mobile, Home Mobile, 
or Other Mobile in MS Outlook? 
There is no issue if you enter values in the specific mobile number 
fields: Mobile (home) and Mobile (business). These fields are 
directly supported by the collaboration system. The issue only exists 
if you use the generic Mobile field. 



DME Client User Guide 4.0 
User guide: Android devices 

 

92  © 2012 Excitor 
 

When this field (Mobile) is updated on the device, and you choose to 
synchronize contacts, DME considers the following work/home scheme. 
Note that each row in the table below lists all completed fields 
related to mobile phone numbers: 

This field in the DME 
Address Book 

 
maps to 

this field in Notes 
or Outlook 

Mobile ->  Work mobile 

Mobile 
Mobile (business) 

-> Home mobile 
Work mobile 

Mobile 
Mobile (home) 

-> Work mobile 
Home mobile 

Mobile 
Mobile (business) 
Mobile (home) 

-> Other mobile 
Work mobile 
Home mobile 

Note: If you are using Lotus Notes, the last row in the table only 
applies if you are running Domino 8 and above. If you are running 
Domino 7, the value in the Mobile field is stored in a hidden field in 
DME, as Domino 7 and below only supports two mobile numbers. 
DME not only employs the work/home scheme to make a qualified 
guess about where to place the mobile phone number, but from all of 
the following fields, which are of the same type as Mobile: 
E-mail 
Fax 
Mobile 
Tel./Telephone 
Address 
 

To-do 

A to-do item is a special type of calendar item and is synchronized 
with your collaboration system by DME.  
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Tap  from the Desktop to open the To-do list view. The To-do 
folder contains a list of the to-dos created on the collaboration 
system or in DME.  

 
A search field at the top of the list lets you search for a particular 
to-do. 
In the DME menu you have the following options: 
 Create 

Create a new to-do. You can also do this by tapping the  icon 
at the top of the screen. 

 Synchronize 
Synchronize to-dos with the collaboration system. 

 Sort 
Sort your to-dos by Subject, Priority, or Date. 

The following notes deal with how DME calculates the 
synchronization window of to-dos. 
For a to-do to be included in the synchronization from the 
collaboration system to the device, the following criteria must be 
fulfilled by the to-do on the collaboration system: 
1. A due date has not been specified, and it has not been marked as 

complete (Domino only). 
2. No start date or end date is specified, and the task is not marked 

as complete. 
3. Or the to-do is overdue and not marked as complete, regardless 

of the values in the starting date and due date fields. 
4. Regardless of the above, a to-do is included if either the starting 

date or the due date is within the time span set in To-do settings 
on page 109 (the sync window). 
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Examples: 
The sync window is set to 10 days in To-do settings, and today is 
April 15th.  
1. A to-do on the collaboration system was created on March 23rd 

with a due date on April 17th. This to-do is synchronized to the 
device because the due date is within the 10-day sync window 
specified in the To-do settings. 

2. Another to-do was created on March 3rd, with a due date of 
March 16th. It has not been marked as completed. This to-do is 
synchronized to the device. When it is marked as completed, it 
will no longer appear on the device. 

 

Creating and editing to-dos 
 Creating and editing a to-do 

1. Tap  from the Desktop to open the To-do list view. 

2. Tap a task to edit it, or tap  to create a new to-do. 

 
You can now enter a subject, set a due date, an alarm, and a 
priority for the to-do, and you can indicate that the to-do is 
Private (meaning that other people opening your calendar in the 
collaboration system cannot see the to-do in question). These 
features are similar to the corresponding calendar item features. 



DME Client User Guide 4.0 
User guide: Android devices 

 

95  © 2012 Excitor 
 

3. Indicate if the to-do is Completed. 
4. Tap Save in the menu to save the to-do in the To-do list. 
 

Files 

If file synchronization is enabled, files can be synchronized using 
scheduled sync or manual sync. Files can be synchronized in one of 
three ways, which is determined by the sync method selected in the 
file rule set up by the DME administrator: 
 One-way, just like receiving an e-mail: The files are downloaded 

to your device if updated on the server since your last sync. 
 Execute: The files are downloaded and executed on your device, 

if they were updated on the server since your last sync. 
 Two-way, just like editing a meeting invitation: The files are 

downloaded to your device if updated on the server since your 
last sync, or uploaded to the server if you updated the files on the 
client since your last sync. 

For a file to be of use on the device, the file type in question must 
have an associated viewer. Not all devices are for instance able to 
view Word documents. For more information, consult your DME 
administrator. 
 

Tools 

The Tools menu in the DME menu contains options that apply to the 
DME client in general. The menu contains the following items: 
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 Settings: Control the look and feel and the operation of your 

DME client. See Settings on page 100. You can also click the  
button from the Desktop. 

 Reset: Refresh the contents of your DME client with a new copy 
from the server. Care should be taken before resetting. See Initial 
import and reset on page 16. 

 Out of office: Lets you enable, disable, or change your out of 
office message. See Out of office on page 99. 

 Change password: With this function, you can change your 
network password. See Changing mailbox passwords on page 
10. 

 Set swipe code: With this function, you can temporarily replace 
your collaboration system password by a simpler swipe code for 
use on the DME client. See Setting swipe code on page 96 below. 

 Log: Displays the event log, which is kept by the DME client. The 
log can be useful in support questions. See If you need further 
assistance on page 114. 

 

Setting swipe code 
For reasons of security, you may be required to enter a long, complex 
password with a mix of letters and special symbols to gain access to 
the network and collaboration system. This may be easy enough to 
enter on a full PC keyboard, but you might find it difficult to enter 
using your phone keypad. 
Instead of using your collaboration system password for logging in, it 
is possible to substitute the password for a swipe code. A swipe code 
is defined by moving your finger across the screen of your phone in a 
certain pattern. 
The DME administrator can set a minimum number of tiles you must 
cover when entering the swipe code. See details below. 
In order to maintain high security on the device, the following special 
conditions apply when using the swipe code instead of the regular 
password: 
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 The code defined by you may expire after some time. The validity 
period of the code is set by the DME administrator, and could for 
instance be 8 hours, corresponding to one working day. The 
validity period begins when you log in to DME using your regular 
password. After this, you can swipe to log in to DME, until the 
validity period runs out. Then you have to use your regular 
password again in order to reset the validity period. You do not 
have to change the swipe pattern. 
The administrator may choose to allow a swipe code that never 
expires, but this is not recommended. 

 If you attempt to log in using swipe, but you enter the pattern 
wrong twice, then you have to use your regular password for your 
next attempt. Your swipe pattern is not invalidated, however - you 
can use it the next time you log in to DME. 

Note that the feature may be disabled entirely by the DME 
administrator for security reasons. 

 Substituting password for swipe code 
1. Log in to the DME client using your regular collaboration system 

password. 
2. Select Tools > Set swipe code in the DME menu. 

If you cannot find this option, it is because the DME administrator 
has disabled it. 
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3. The following screen consisting of 12 tiles is shown: 

 
4. Move your finger vertically, horizontally and diagonally across any 

of the 12 tiles in the screen. For the pattern to become a valid 
swipe code, you must cover at least the number of tiles that are 
defined as the minimum PIN/swipe code length by the DME 
administrator. 

5. Repeat the swipe to confirm the new swipe code. 
If you accidentally move your finger across tiles that you did not 
intend to touch, you can undo the current swipe by continuing to 
move your finger outside the swipe area. You can then try again. 

Tap OK to close the swipe code definition screen. Your new swipe 
code is set. 
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Out of office 
With DME, you can create, edit, enable, and disable your 
Out-of-Office (OOF: Out-of-Office Functionality) message. When you 
synchronize, the information added here will update the Lotus Notes 
agent or Microsoft Outlook rule in the collaboration system. This way, 
you can for instance enable your OOF agent from your phone, if you 
forgot to do so during the last hectic hours at the office before your 
vacation. 
To configure your OOF rule, select Tools > Out of office. DME 
connects to the server to read the current OOF settings from the 
collaboration system. 

 
 Enabled 

Select this field to enable the Out-of-Office agent/rule; deselect 
the field to disable the agent/rule. 

 Start 
In this field you can choose a date and time at which the OOF 
agent/rule should become active, if enabled. 

 End 
In this field you can choose a date and time at which the OOF 
agent/rule should become inactive again. 

 Description 
In this field you can enter or edit the text which will be used in 
the automatic response to people who write to you while the 
OOF agent/rule is enabled. 

When you are done, select Change or Update (depending on 
device) to synchronize the agent or rule with the collaboration 
system. There are a few things you should be aware of in the way the 
OOF agent is handled by Lotus Notes and MS Outlook: 
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Lotus Notes: DME does not support the Lotus Notes system of 
alternate notifications. The text from the Description field will be 
used as both main and alternate notification. 

 
Exchange 2003: Exchange 2003 does not support start and end days 
for OOF rules, and the dates will be ignored by Exchange 2003. 
Exchange 2007/2010: DME does not support different reply 
messages for internal and external recipients. The text from the 
Description field will be used for both types of recipients. 
 

Settings 

When a new device is created in DME, a set of default settings for the 
device is sent to the client the first time the device connects with the 
server, or when a new user takes over an existing device. These 
settings should represent your company's security policy.  
Note that the DME administrator may have blocked your access to 
changing any or all of the settings described in the following sections. 
When a "permitted range" is mentioned in the following sections, the 
range may in fact have been changed by the DME administrator. 
The "Deployment guide" contains information for DME administrators 
about recommended settings and permitted range values. 
 

General settings 
 Launch on startup 

Select Yes/Enabled to make the DME client launch every time 
you start your device. This is default and highly recommended for 
security purposes. 
Select No/Disabled if you want to start the DME client manually. 

 Phone number 
The phone number of the device. The DME server needs to know 
your phone number for sending SMS messages and pushing 
downloads etc. to the device. 

 Server path 
This is the path to the DME server. You set this value once, the 
first time you start DME. The server path should rarely be 
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changed, and only if your DME Administrator tells you to. For 
more information, see Logging in for the first time on page 22. 

 Network push 
If this function is enabled, the device is set up to receive network 
(IP) push. This means that notifications are received over the 
GPRS network instead of by SMS. The result is faster and usually 
cheaper notification. This requires that the DME server is set up 
correctly. If the GPRS network is for some reason unavailable, the 
DME server will detect this and send notifications by SMS instead. 
This system of falling back to SMS is called AdaptivePush™. 
Whenever network push is enabled and working on your device, a 
flash icon  is displayed next to the DME logo at the top of your 
DME client. 
Note that this feature may be disabled if you are roaming. For 
more information, see Roaming. 

 Network push path 
If network (IP) push is enabled, you must supply a path to the 
server providing the network push connection. This path is 
usually pushed to your device by the DME server. Please 
contact your DME administrator for more information. 

 IM awareness 
If your company uses the IBM Sametime instant messaging (IM) 
application, you can select this field to see the Sametime status 
of your Sametime contacts (buddy list). If you do this, a symbol 
next to the name of the sender of an e-mail in a mailbox 
indicates his or her Sametime status: Away , In a meeting 
, Do not disturb , or Available . Please note that in order 
to use this feature, Network push must be enabled as well 
(see above). 

 'Back' action in Login screen 
In this field you can specify the action of the secondary (Back) key 
when the Login screen is shown. The following choices are 
available: 
 Exit DME: This is the default setting. Pressing the secondary 

key exits the DME application. 
 Hide DME: If you select this option, pressing the secondary 

key will hide (minimize) DME without logging the user out. 
Note that by selecting this, both the Exit action and the 
Login action are moved in as sub-items in the DME menu. 

 'Back' action on Desktop 
In this field you can specify the action of the secondary (Back) key 
when the Desktop is shown. The following choices are available: 
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 Lock DME: This is the default setting. Pressing the secondary 
key from the Desktop locks DME and shows the Login 
screen. 

 Hide DME: If you select this option, pressing the secondary 
key will hide (minimize) DME without logging out the user. 

 Allow sync when roaming 
If this field is set to Disabled, you will not be able to perform 
manual synchronization when using a roaming network. When 
roaming, you will see a message saying that synchronization is not 
allowed when roaming if you try to perform a manual 
synchronization. 
The device uses information from the SIM card when checking if it 
is currently roaming. As soon as the phone is no longer roaming, 
you are able to synchronize manually again. Performing a manual 
sync will also inform the server that the device is no longer 
roaming, which is necessary for re-enabling background sync. See 
also Bgr. sync when roaming. 
This setting is for your information only - it cannot be changed 
from the device. 

 Bgr. sync when roaming 
If this field is set to Disabled, the device will not perform 
background synchronization when using a roaming network. 
Background synchronization covers scheduled synchronization, 
e-mail and PIM pull, and SMS push notification. If Allow sync 
when roaming is enabled, you will still be able to synchronize 
manually. 
The roaming status of the device is stored on the server. The first 
background sync performed while roaming will therefore be 
carried out normally, but will also inform the server that the 
device is roaming, effectively cutting the device off from further 
background synchronization. This means that the server is unable 
to detect that the device is back in the home network, unless you 
perform a manual sync. When using this cost-saving feature, it is 
important to that you perform a manual sync when you return to 
your home network. 
This setting is for your information only - it cannot be changed 
from the device. 

 NW push when roaming 
As a cost-saving feature, the administrator can disable the network 
(IP) connection when the device is roaming by setting this option 
to Disabled. If the server setting Notify when roaming is 
enabled, the server will resort to SMS push (if permitted by the 
notification schedule that applies to the device). If Notify when 
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roaming is disabled also, the device will receive no notification at 
all. 
To update the roaming status, you should perform a manual 
synchronization when you return to your home network. 
This setting is for your information only - it cannot be changed 
from the device. 

 

Security settings 
With these settings, you specify the security aspects of DME on your 
device. 

 Action on SIM change 
In this field you can choose how the DME client should react when 
a new SIM card is inserted into the device. You may need more 
than one SIM card, for instance if you travel and use local prepaid 
SIM cards. However, simply allowing SIM card changes poses a 
security threat, as a malevolent user might steal a device and 
insert his own SIM card in order to (potentially) gain access to 
files and other data on the device. Therefore you can choose 
among three options in this field: 
 None 

If you select this option, the DME client will do nothing when a 
user changes SIM cards. This is usually not recommended for 
the above stated reasons. 

 Flush data 
If you select this option, the DME client will flush (delete all 
DME data from) the device if another SIM card is inserted. For 
more information, see Data security on page 9. 

 Client certificate 
If Client signing is enabled on the DME server, you can only 
establish a connection with the server if your device is known and 
trusted by the server. This is achieved through a system of 
certificates. If a new certificate is generated for the device, you 
will need to delete the existing certificate on your device. If the 
value in this field is Select to remove, a client certificate is in 
force on your device, and you can delete it. You should only do 
this if you are asked to do so by a DME Administrator, as you will 
not be able to log on again until the DME Administrator initiates 
the creation of a new certificate. 

 Private key password 
In this field you can specify your password for your private key. 
Your private key is used for decrypting encrypted messages sent 
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to you, and for signing private messages. If you do not enter a 
password here, you cannot read encrypted messages or sign new 
messages from your mobile device. 
If your collaboration system is using Notes Encryption, you 
must enter the password for your user ID file. 
If your collaboration system is using S/MIME, enter the password 
for your private key in this field. You must also upload your 
personal certificate to the DME server (using myDME).  
For more information about Notes Encryption, S/MIME, and 
myDME, please contact your DME administrator. 

 Logout timeout (min) 
The DME client is locked automatically after the specified number 
of minutes of inactivity. The value 0 means never logout 
automatically (not recommended). Permitted range: 0-600 
minutes. 

 

E-mail settings 
In the e-mail settings screen you specify the synchronization and 
other aspects of e-mail in the DME client on your device. 
 E-mail sync. 

If you select Enabled/On, e-mail synchronization is enabled. This 
setting affects push mail, e-mail pull, manual synchronization, and 
scheduled sync. 
If you select Disabled/Off, e-mails are never synchronized. 

 Days back 
When e-mails are synchronized, e-mails from the last number of 
days selected here will be synchronized and available in the Inbox. 
Permitted range: 0-99 days. 

 Send immediately 
If you select No, e-mails are stored in the Outbox folder when 
you select Send, and are not sent until the next scheduled or 
manual synchronization. 
If you select Send only, e-mails created on the device are sent 
immediately when you select Send from a new e-mail or meeting 
invitation, but any new items are not retrieved from the server. 
This significantly reduces the load on the server and the time it 
takes to synchronize. 
If you select Send & Receive, e-mails created on the device are 
sent immediately when you select Send from a new e-mail or 
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meeting invitation - that is, a regular e-mail synchronization is 
performed. 
Mail alert options: 

 Sound on 
If you select this check box, the device will play the sound selected 
in the field Mail alert when you receive an e-mail in DME. 
 Alerts start 

In this field you can specify the time of day from which you 
want to begin receiving audible alerts when a new e-mail 
arrives. Use the local time format, for instance hh:mm:ss or 
hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 Alerts end 
In this field you can specify the time of day from which you no 
longer want to receive audible alerts when a new e-mail 
arrives. Use the local time format, for instance hh:mm:ss or 
hh:mm:ss am/pm. Example: 18:00 or 06:00 am. 

 Mail alert 
Tap this option to select which sound you want hear when you 
receive a new mail in DME. Requires that Sound on is 
enabled. 

 Alert volume 
In this field you can specify the volume of the alerts you hear 
when a new e-mail arrives. 

 Vibrate 
If you enable this option, the device vibrator will be activated 
when a new mail is received by DME. 

E-mail pull options: 
 E-mail pull 

If you select Enabled, client-initiated (pull) synchronization of 
e-mail is enabled. This corresponds to the Scheduled sync. 
settings on page 110, but is independent of the synchronization 
schedule set up on the DME server. 
Select Disabled to disable the client-initiated sync. of e-mail. 
Note that this feature may be disabled if you are roaming. For 
more information, see Roaming. 
 Pull interval 

If E-mail pull is enabled, the client will initiate a sync. every 
number of minutes selected here. Permitted range: 10-120 
minutes. 

 Start time 
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In this field you can specify the time of day after which 
client-initiated pull should start, if this is enabled. Use the local 
time format, for instance hh:mm:ss or hh:mm:ss am/pm. 
Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which 
client-initiated pull should end, if this is enabled. Use the local 
time format, for instance hh:mm:ss or hh:mm:ss am/pm. 
Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, client-initiated pull will continue to run over 
the weekend. 
If you select No, client-initiated pull will not run on weekends. 

Signature options: 
 Signature 

Any text you enter in this field will be appended to all new e-mails 
sent from the DME client. You typically use it for adding a 
signature. Note that the DME administrator can add another text 
to be appended to e-mails, called an "E-mail disclaimer". DME will 
add the signature from this field first, and then the e-mail 
disclaimer will be added by the DME server at the very end of the 
e-mail (after any reply history). 

 

Folders settings 
The folder settings screen is only visible if the DME administrator has 
enabled folder synchronization on the server. If enabled, you are able 
to view your mailbox folders (as created in Outlook or Notes) and 
any e-mails in these folders on the device. 
This screen contains settings which act as default settings for all 
folders. From this screen you can also force the default settings on all 
mailbox folders.  
In the Folders screen, you can apply different settings to individual 
folders (see Setting folder options). In the individual folder setup 
screen, you can also flush the individual settings and re-apply the 
default settings, which are made in this screen. 
 Folders sync. 

In this field you can choose to enable synchronization of e-mails in 
subfolders by default. The e-mails are synchronized for the 
number of days specified in the Days back field. You can change 
the setting for individual e-mail folders (see Setting folder options). 
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Regardless of this setting, the folder structure as such (without 
e-mails) is synchronized between the collaboration system and the 
device. You need the folder structure when choosing where to 
search for e-mails on the server - see E-mails (on server) on page 
58 and for moving e-mails to other folders. 

 Days back 
In this field you can specify how many days back the DME client 
should synchronize e-mails in subfolders. Note that with higher 
numbers, the load on the DME server will increase. This number 
may be changed for individual folders. 

 Apply to all folders now 
This option will always be off when you open the folder settings 
tab. Think of this option as an action button - if you select it, the 
settings for Days back and Sync. folders made in this window 
will be applied to all folders instantly, regardless of their individual 
settings. This is a way to realign all folder settings with default 
values. 

 

Calendar settings 
In the calendar settings, you specify the synchronization and other 
aspects of calendar items in the DME client on your device. 
 Calendar sync. 

If you select Enabled, calendar synchronization is enabled. This 
setting affects push notification, calendar pull, manual 
synchronization, and scheduled sync. 

If you select Disabled, calendar items are never synchronized. 
 Days back 

When items are synchronized, items from the last number of days 
selected here will be synchronized and available in the device. 

 Days forward 
When items are synchronized, items up until the number of days 
selected here will be synchronized and available in the Calendar. 

 Alarm sound 
If you enable this setting, DME will play the calendar alarm 
specified in the Sound field below when displaying a calendar 
alert. 

 Set alarm sound 
With this setting, you can choose which sound among the installed 
ringtones you want to use as calendar alarm. 



DME Client User Guide 4.0 
User guide: Android devices 

 

108  © 2012 Excitor 
 

 Vibrate 
If you enable this setting, DME will activate the phone vibrator 
when displaying a calendar alert. 

 Flashing LED 
If you enable this setting, DME will flash the LED light when 
displaying a calendar alert (not all devices support this feature). 
Calendar pull options: 

 Calendar pull 
If you select Enable, client-initiated (pull) synchronization of 
calendar items is enabled. This corresponds to the Scheduled 
sync. settings on page 110, but is independent of the 
synchronization schedule set up on the DME server. 
Select Disable to disable the client-initiated sync. of calendar 
items. 
Note that this feature may be disabled if you are roaming. For 
more information, see Roaming. 

 Pull interval 
If Calendar pull is enabled, the client will initiate a sync. 
every number of minutes selected here. 

 Start time 
In this field you can specify the time of day after which 
client-initiated pull should start, if this is enabled. Use the local 
time format, for instance hh:mm:ss or hh:mm:ss am/pm. 
Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which 
client-initiated pull should end, if this is enabled. Use the local 
time format, for instance hh:mm:ss or hh:mm:ss am/pm. 
Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, client-initiated pull will continue to run over 
the weekend. 
If you select No, client-initiated pull will not run on weekends. 

 

Contacts sync. settings 
 Contacts sync. 

If you select Enabled/On, contact synchronization is enabled, and 
your list of contacts on the device will be kept in sync with your 
personal address book on the collaboration system. 
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If you select Disabled/Off, contacts are never synchronized. 
 Device Address Book/Contacts 

With the settings in these fields you can choose how DME should 
interact with the native address book on your device - the 
Contacts application. DME contains an internal address book - the 
DME Address Book. You can choose to keep your business contacts 
in the DME Address Book and your private contacts in the native 
Contacts application - for reasons of security, work/life balance, or 
both. The degree of interaction can be chosen at three levels: 
 Copy all fields (Open): Contacts from DME are shown in 

the native Contacts application, and the two address books are 
kept synchronized insofar as the native contacts application 
supports the DME address book fields. Note that when you 
select this option, DME will start exporting contacts to the 
Contacts application immediately. 

 Copy name and phone numbers (Mixed): As Copy all 
fields, but only the name and phone numbers from the DME 
Address Book are shown in the native Contacts application. If 
you edit the name or phone number in your native Contacts 
application, this information will be synchronized to the DME 
Address Book. However, if you add any other information to 
your native contacts, this information will be removed again by 
DME. In other words, you should use DME for maintaining 
your contacts. Note that when you select this option, DME 
will process the contacts in the Contacts application 
immediately, so they only show name and number. 

 Don't use (Secure): There is no interaction - contacts in the 
DME Address Book and the native Contacts are kept 
completely separate. This lets you keep your business contacts 
in DME in sync with your collaboration system, while letting 
you synchronize your personal contacts with other contact 
synchronization applications. Note that when you select this 
option, DME will delete any contacts in the Contacts 
application, which are also found in the DME Address Book, 
immediately. 

For more information, see Interaction with the device Contacts 
on page 81. 

 

To-do settings 
 To-do sync. 

If you select Enabled, to-do item synchronization is enabled. This 
setting affects push notification, manual synchronization, and 
scheduled sync. 
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If you select Disabled, to-dos are never synchronized. 
 Days back 

When to-dos are synchronized, items from the selected number 
of days back in time will be synchronized and available in the 
device. See To-do for more information. 

 Days forward 
When to-dos are synchronized, items with a date up until the 
selected number of days ahead in time will be synchronized and 
available in the device. 

 

Files settings 
With this setting, you enable or disable the synchronization of files. 
File synchronization requires a special license and is set up on the 
DME server. For more information, please ask your DME 
administrator. 
 File sync. 

If you select Enabled, file synchronization is enabled. This setting 
affects push notification, manual synchronization, and scheduled 
sync. 
If you select Disabled, files are never synchronized. 

 

Scheduled sync. settings 
With these settings, you specify options for scheduled 
synchronization. Note that this feature may be disabled if you are 
roaming. For more information, see Roaming. 
 Scheduled sync. 

If you select Enabled, the DME client will initiate synchronization 
of the enabled resources (e-mail, calendar, etc.) according to the 
schedule specified below. 
If you select Disabled, the synchronization of resources relies on 
client-initiated sync (pull, where applicable), manual 
synchronization, or push notification from the mail system. 

 Interval 
If Scheduled sync. is enabled, the client will accept a sync. every 
number of hours selected here. Permitted range: 1-24 hours. 

 Start time 
In this field you can specify the time of day after which scheduled 
sync. should start, if this is enabled. Use the local time format, for 
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instance hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 
08:00 am. 

 End time 
In this field you can specify the time of day at which scheduled 
sync. should end, if this is enabled. Use the local time format, for 
instance hh:mm:ss or hh:mm:ss am/pm. Example: 17:30 or 
05:30 pm. 

 Run on weekends 
If you select Yes, scheduled sync. will continue to run over the 
weekend. 
If you select No, scheduled sync. will not run on weekends. 

 

Desktop settings 
 Log in to 

In this field you can specify which screen you want to see after 
logging in to the DME client. You can choose between the 
following options: 
 Desktop: DME starts in the Desktop view after logging in. 
 Inbox: DME opens the Inbox after logging in. 
 Calendar: DME opens the Calendar after logging in. 
 To-do: DME opens the To-do screen after logging in. 
For more information, see The DME Desktop on page 29. 

 

Menu tree 

If you have access to the full DME client, the menu structure of the 
DME client is as follows. Note that the DME menu structure is 
dynamic. If your license does not include all functionality, or if some 
functionality is turned off by the DME Administrator, there will be 
less menu items than shown below. 
 

Create 
 E-mail 

Create a new e-mail. 
 Meeting 

Create a new meeting invitation or appointment. 
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Synchronize 
 E-mail 

Synchronize e-mails only. 
 Calendar 

Synchronize calendar items only. 
 Contacts 

Synchronize contacts only. 
 To-do 

Synchronize to-dos (tasks) only. 
 Files 

Synchronize files only, if enabled. 
 Sync. all 

Synchronize all resources. 
 Cancel sync. 

Cancel an ongoing synchronization. Any changes made will be 
rolled back. 

 

Search 
 Global Address Book 

Search for e-mail address on the server. 
 E-mails (on server) 

Search for e-mails in your server mailbox. 
 E-mails (on phone) 

Search for e-mails stored locally. 
 

Actions 
 Delete selected 

(If item is selected) Delete the current item. 
 Mark selected read 

(If item is selected) Mark selected items as read. 
 Mark all read 

(If no item is selected) Mark all items as read. 
 Mark selected unread 

(If item is selected) Mark selected items as unread. 
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 Mark all unread 
(If no item is selected) Mark all items as unread. 

 Move to folder 
(If item is selected) Move the current item to another folder. 

 Flag 
(If item is selected) Flag selected items as follow-up items. 

 Clear flag 
(If item is selected) Remove follow-up flag from selected items. 

 Delete all attachments 
(If no item is selected) Removes all downloaded attachments from 
the phone. 

 

View 
 Folders 

Go to the Folders view, where you can choose which mailbox 
folder you want to work in. 

 Calendar 
Go to the internal DME calendar. 

 Contacts 
Go to the internal DME contacts. 

 To-do 
Go to the to-do list. 

 

Tools 
 Settings 

Set up different aspects of DME on your device: General, 
Security, E-mail, Folders, Calendar, Contacts, To-dos, Files, 
Scheduled sync., Desktop. 

 Reset 
Reset (wipe and load) all synchronized items from the 
collaboration system to your device. 

 Out of office 
Manage your out of office agent or rule. 

 Change password 
Change your LDAP/AD password to match that on the server. 
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 Set swipe code 
Set a swipe gesture as a temporary replacement for your LDAP 
password. 

 Log 
Show the client's event log, and optionally save it as a file. 

See Tools on page 95 for more information. 
 

More 
 Lock 

Lock DME (log out). 
 Hide 

Hide DME (move DME to background, but remain logged in). 
See also the General settings on page 100 for information about 
configuring the Back key. 

 About DME 
Display version information, OS information, and license 
agreement text. 

 

If you need further assistance 

If you have read this guide and still have questions concerning the 
function and usage of the DME client, please contact your DME Help 
Desk (usually the internal IT department). 
Before contacting your DME Help Desk, be sure to have information 
about your DME version etc. ready: 

 Finding helpdesk information about your DME client 
1. Open the DME menu. 
2. Select More > About DME. 
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A window displays information you can use in connection with 
helpdesk inquiries. Apart from the product name and a copyright 
notice, the window shows the following information: 
 Version number (for instance 4.0) 
 Release date (for instance 2012-07-11 13:00:00) 
 Information about the Android OS 
 Copyright information 
 The End User License Agreement (EULA) 

Furthermore, DME keeps a log of the events that take place in the 
client. The events are split into two log files: userlog.txt, which 
records basic information such as how many e-mails were received 
and when, and log.txt, which contains more technical information. 

 Showing the DME client event log 
1. Open the DME menu. 
2. Select Tools. 
3. Select Log. 

The client log (userlog.txt) is shown. The DME menu contains a 
number of options: 
 Go to first line: Browse to the top of the log. 
 Go to last line: Browse to the end of the log. 
 Save on SD card: Save the log files to 

/sdcard/dme/userlog.txt and ../log.txt on the memory 
card. 

 Start/Stop Live mode: Tapping the icon alternates between 
two modes: Start means that the log is in continuous mode 
(live log) - the screen keeps showing new entries in the log. 
Stop breaks the continuous loading and pauses the log screen. 
Tapping it again resumes the live log. 

 Clear: Delete the log. 
 Send: Save the log files, open a new e-mail, and attach the 

logs. This is especially useful if you need to send the logs to 
support. 

The DME administrator can request the client event log using a 
feature in the DME Server. 
If you are the DME administrator, and you need more help, you can 
contact your DME Partner. You can also check the DME Support 
http://www.excitor.com website for more information. 
If you find errors or omissions in this documentation, please contact 
Documentation feedback see Documentation feedback - 
mailto:documentation@excitor.com?Subject=Documentation 
feedback. 
 

http://www.excitor.com/
mailto:documentation@excitor.com?Subject=Documentation%20feedback
mailto:documentation@excitor.com?Subject=Documentation%20feedback
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List of procedures 

 Logging in to DME for the first time 23 

 Uninstalling the DME client for Android 28 

 Opening an attachment 39 

 Removing all attachments from the device 42 

 Viewing e-mail details 43 

 Creating and sending an e-mail 44 

 Setting message options 46 

 Saving an e-mail as a draft 46 

 Replying to an e-mail 47 

 Forwarding an e-mail 47 

 Sending attachments in original e-mails and replies 48 

 Sending attachments in forwarded e-mails 50 

 Adding attachments to meeting invitations 50 

 Marking selected or all e-mails as read or unread 52 

 Deleting one or more selected items 52 

 Deleting a single e-mail 52 

 Deleting the currently open e-mail 53 

 Setting or removing follow-up flag 53 

 Moving selected e-mails to another folder 53 

 Finding contacts in the global address book 55 

 Searching for e-mails on the server 58 

 Searching for an e-mail locally 60 

 Calendar options for the meeting chair 65 

 Calendar options for meeting participants 67 

 Responding to a meeting invitation 68 

 Creating a new meeting 71 

 Downloading rooms and resources 74 

 Selecting rooms and resources 75 

 Checking free time 77 

 Adding contacts: Android 1.5/1.6 84 

 Editing contacts 85 

 Adding contacts: Android 2.1 86 
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 Editing contacts 87 

 Adding contacts: Android 2.2 or later 88 

 Editing contacts 89 

 Viewing DME contacts in native contacts application 90 

 Creating and editing a to-do 94 

 Substituting password for swipe code 97 

 Finding helpdesk information about your DME client 114 

 Showing the DME client event log 115 
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